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France
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NICE invites you to join the NICE User Group (NUG). 

Visit the NUG Website at www.niceusergroup.org, and follow the online instructions. 
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1

Get Ready for NICE Perform eXpress! 

NICE Perform eXpress can be easily and quickly installed in just a few hours using a simple and 
intuitive installation and configuration process. It can be installed and configured either from a 
central location or at the local site.

In organizations where several NICE Perform eXpress systems are installed, it is possible to 
provide a common configuration for all the systems simultaneously. Then finalize the 
configuration of each system either remotely or locally.

This guide provides instructions for installing and configuring the Avaya TSAPI Passive VoIP 
Dynamic IP telephony environment. 

To install and configure a Mixed Environment, where two telephony environments are installed 
on one NICE Perform eXpress, you will need to work with the installation guide for each 
telephony environment. 

Contents

NICE Perform eXpress Installation Workflow ..............................................................12

Quality Management: Evaluations and Screen Recording.........................................13

Setting Up a Workstation or Agent Desktop ................................................................14

What Will I Find in Other NICE Perform eXpress Guides? .........................................15

Where are the NICE Perform eXpress Tools? ..............................................................18

Limitations.......................................................................................................................19

IMPORTANT 
The Avaya TSAPI Passive VoIP Dynamic IP telephony environment is not supported on a 
Windows 2008 Operating System. It must be installed on a Windows 2003 Operating System.
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NICE Perform eXpress Installation Workflow

NICE Perform eXpress Installation Workflow
The Avaya TSAPI Passive VoIP Dynamic IP telephony environment is comprised of the 
following: 

Use the following workflow to install and start using your NICE Perform eXpress. Except where 
indicated, all procedures appear in this guide.

Telephony Switch Type Avaya CM

CTI Interface AES TSAPI

Reporting Type CTI

Recording Type Passive VoIP

Table 1-1:  

Procedure Page Installer’s Notes

1. Prepare a machine for NICE Perform eXpress. 
See the NICE Perform eXpress Pre-Installation 
Guide.
In a Mixed Environment do this only one time.

2. Time Setup for NICE Perform eXpress
In a Mixed Environment do this only one time.

21

3. Configure the switch for NICE Perform eXpress.
Switch configuration is the responsibility of the 
site administrator. Guidelines are provided in 
Preparing the CTI for NICE Perform eXpress

149

4. Installing the Avaya AES TSAPI Client 27

5. Installing NICE Perform eXpress
In a Mixed Environment do this only one time.

33

6. Configuring NICE Perform eXpress 67

7. Managing Users and Groups 113

8. Initializing Backup 131

9. Testing your NICE Perform eXpress 135
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Quality Management: Evaluations and Screen Recording
If your site has a Quality Management license, you can do the following:

1. Mark interactions for QM monitoring and evaluations.

2. Record screens together with voice interactions.

For details on using Quality Management, see the Quality Management Guide.

To mark interactions for QM do the following:

• In the Storage and Rules tab of the Configuration application, create QM rules to mark 
interactions QM. See Defining Quality Management (QM) Rules on page 107.

To record screens do the following:

1. In the Storage and Rules tab of the Configuration application, define screen storage. See 
Defining Screen Recording on page 106.

2. Create QM rules to initiate screen recording. See Defining Quality Management (QM) 
Rules on page 107.

3. On all workstations where screens will be recorded, run the Client Installation. See Quality 
Management: Client Installation for Screen Recording on page 216.

On all workstations where screens will be viewed, do the following:

• Run the Client Installation. See Quality Management: Client Installation for Screen 
Recording on page 216.
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Setting Up a Workstation or Agent Desktop

Setting Up a Workstation or Agent Desktop
There are three different workstation scenarios for NICE Perform eXpress users:

• A user (administrator) logs in to NICE Perform eXpress on the machine where it is installed.

• A user (administrator) logs in to NICE Perform eXpress on a different machine connected to 
the NICE Perform eXpress machine for the purpose of managing agents and using NICE 
Perform eXpress applications.

• An agent is recorded by NICE Perform eXpress and does not ever log in to NICE Perform 
eXpress.

To prepare a workstation proceed as follows:

4. In the first two scenarios above, the workstation must be prepared according to Configuring 
Internet Explorer for NICE Perform eXpress on page 212.

5. If you have a Quality Management (QM) license, the NICE Client installation must be run 
on all machines where agent screens will be recorded or played back. This includes agent 
workstations where the agent is recorded but never logs in to NICE Perform eXpress. See 
Quality Management: Client Installation for Screen Recording on page 216.
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What Will I Find in Other NICE Perform eXpress Guides?
The documentation for NICE Perform eXpress is divided into a number of guides. The following 
table explains the audience and main tasks for each of these guide types:

NICE Perform eXpress 
Guide Audience Provides Instruction To...

Administrator’s Guide IT Professional • Understand system alerts and backup device 
status.

• Update licenses.

• Verify channel activity.

• Monitor channels in real time.

• Define users and groups.

• Query audit messages.

• Define extended retention for storage.

Central Administration 
Guide

IT Professional • Define CTI and storage parameters at one 
central location for use at all locations 
(Branches).

• Deploy CTI and storage definitions to the 
Branches.

• Create IT administrators who can access and 
manage all the Branches.

• Update existing CTI and Storage 
configurations at all NICE Perform eXpress 
Branches.

Installation Guides NICE Installer • Install the NICE Perform eXpress hardware 
and software.

• Configure NICE Perform eXpress for the 
telephony environment.

• Prepare the CTI for NICE Perform eXpress. 
(Guidelines are provided: The CTI setup is the 
responsibility of its manufacturer.)

Interactions Guide: Query 
and Playback

Manager or 
Agent/Trader

• Run a built-in query to find interactions and 
play them back.

• Create a customized query to find specific 
interactions.

• Save an interaction from NICE Perform 
eXpress to a standard format in order to play it 
back on any media player.
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Maintenance Guide IT Professional, 
NICE Installer

• Verify the NICE Perform eXpress system is 
functioning correctly by means of a Support 
Calendar.

• Maintain the NICE databases.

• Expand an existing NICE Perform eXpress 
system on the same server and to a 
replacement machine.

• Replace faulty boards.

• Recover a system.

• Manage NICE Services and logs.

• Respond to SNMP traps.

• Manage NICE Perform eXpress versions and 
updates.

• Change the server name. (Business Partners 
only)

Migrating from NiceCall 
Focus III and NiceUniverse 
8.9

Business 
Partner

• Migrates NiceCall Focus III and NiceUniverse 
8.9 systems to NICE Perform eXpress.

Pre-Installation Guide NICE Installer • Select the correct server/PC for the NICE 
Perform eXpress system.

• Harden the machine in order to prepare a 
secure environment for the NICE Perform 
eXpress system.

• Install the required software before installing 
the NICE Perform eXpress system.

• Verify the necessary anti-virus requirements.

Quality Management Guide Manager, 
Agent/Trader or 
IT Professional

• Configure quality management, which 
includes setting up screen recording, defining 
QM rules, monitoring client machines, and 
defining QM users.

• Create forms for quality management.

• Query for interactions marked for QM.

• Evaluate agents/traders.

• Generate reports.

NICE Perform eXpress 
Guide (Continued) Audience Provides Instruction To...
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Troubleshooting Guide IT Professional, 
NICE Installer, 
Business 
Partner

• Manage NICE Services and logs.

• Respond to SNMP traps.

• Troubleshoot:

• Licensing

• Archiving

• Playback

• Recording

• PCI eXpress Interface Boards

• Integrations (Vendor-side)

Upgrade Guide NICE Installer • Upgrade NICE Perform eXpress from 
Releases 1.0 and 2.1 to Release 3.0.

NICE Perform eXpress 
Guide (Continued) Audience Provides Instruction To...
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Where are the NICE Perform eXpress Tools?
The tools for NICE Perform eXpress are documented in the Installation Guides, the Maintenance 
Guide, the Troubleshooting Guide, and Migrating NiceCall III and NiceUniverse 8.9. A key to the 
documentation for each tool is listed below:

Tool Documented in these NICE Perform eXpress Guides

Archive Tool • Migrating NiceCall Focus III and NiceUniverse 8.9

Board Diagnostic Tool • Troubleshooting Guide

Board Numbering Tool
Not applicable for boards from NICE Perform 
eXpress 1.0 

• Installation Guides

• Troubleshooting Guide

eXpress Assistant • Installation Guides

• Troubleshooting Guide

Log Collector • Maintenance Guide

• Troubleshooting Guide

Log Viewer • Maintenance Guide

• Troubleshooting Guide

NICE Migration Application • Migrating NiceCall Focus III and NiceUniverse 8.9

Performance Collector • Troubleshooting Guide

Rename Host • Maintenance Guide

Security Configuration Tool • Maintenance Guide

Services Configuration Manager • Maintenance Guide

• Troubleshooting Guide

Site Readiness Tool • Pre-Installation Guide
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Limitations
The following limitations are currently in effect for the NICE Perform eXpress 3.0 installation. 
This installation guide contains only those limitations that directly affect installation. For a 
complete list of limitations, refer to the latest Release Note.

# Known Issues and Limitations

1. Avaya TSAPI is not supported on Windows 2008.

2. Avaya TSAPI and Alcatel TSAPI cannot be part of the same mixed environments.

3. Windows Update installation might cause NICE Perform eXpress installation or NICE 
Perform eXpress Update Pack installation to fail.
Verify that Windows Update installation is not running before beginning installation.

4. From the pre-installation stage onwards, the NICE Perform eXpress machine must be 
connected to the network at all times.

5. Recording may stop after applying changes to disable or enable use of Backup 
Devices. Verify that the NTLogger service is started. If the NTLogger service is not 
started, restart the machine.

6. In a mixed environment, when one environment is deleted, Channel Monitoring might 
stop working. Workaround: Delete both environments and reconfigure.

7. When migrating from NiceCall Focus III or NiceUniverse 8.9, tapes recorded with 
compression type PCM µ-law cannot be retrieved by NICE Perform eXpress.

8. If a system has two NICs, and one of the NICs is not connected to the network, the 
disconnected NIC must not be selected in the NIC for sniffing configuration of the 
CTI and Recording tab when defining the configuration.
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Time Setup for NICE Perform eXpress

Before you begin installing your NICE Perform eXpress system, configure your NICE Perform 
eXpress machine with the correct date, time, and time zone. You must also prepare it for 
daylight saving time. Once you begin the installation process, you will not be able to reset the 
date, time, or time zone.

Contents

Preparing the Server for Daylight Saving Time ...........................................................22

Setting Time without an NTP Server.............................................................................23

Setting Time with an NTP Server ..................................................................................24

WARNING 
If you make any changes to the Date, Time, or Time Zone after your system is installed, your 
license will become invalidated. In this event, contact NICE Support and see the 
Troubleshooting Guide for further information.
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Preparing the Server for Daylight Saving Time
Before you begin installing your NICE Perform eXpress system, configure your NICE Perform 
eXpress machine with the correct date, time, and time zone, and define daylight saving time. 
Once you begin the installation procedures, you will not be able to reset the date, time, or time 
zone.

Remember! After you have completed the procedure below, you do not have to reset any clocks 
or restart your machine when Daylight Savings Time begins or ends.

Follow the instructions in one of the following procedures:

• If your site does not use an NTP server for time synchronization, define Daylight Saving Time 
on the Time Zone tab as described in Setting Time without an NTP Server on page 23.

-or-

• If your site uses an NTP server for time synchronization, define the server on the Internet 
Time tab as described in Setting Time with an NTP Server on page 24. 

WARNING 
If you make any changes to the Date, Time or Time Zone after your system is installed, your 
license will become invalidated. In this event, contact NICE Support and see the 
Troubleshooting Guide for further information.
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Setting Time without an NTP Server
If your environment does not use an NTP server for time synchronization, use the following 
procedure to set time and prepare for Daylight Saving Time.

To set date and time parameters:

1. Right-click the clock in the Notification area, and select Adjust Date/Time.

-or-

From the Start menu, select Settings > Control Panel. Then double-click Date and Time.

The Date and Time window appears.

2. To change the current time, click Change date and time.

3. In the Time zone area, click Change time zone.

The Time Zone Settings Window appears.

4. In the Time zone box, select the time zone at your site. 

5. Select Automatically adjust clock for Daylight Saving Time.

6. Click OK to close the Time Zone Settings window.

7. Click OK to close the Date and Time window.

Select
Select a
Time Zone

this option
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Setting Time with an NTP Server
If your environment uses an NTP server for time synchronization, use the following procedure to 
set time and prepare for Daylight Saving Time.

To set date and time parameters:

1. Right-click the clock in the Notification area, and select Adjust Date/Time.

-or-

From the Start menu, select Settings > Control Panel. Then double-click Date and Time.

The Date and Time Properties window appears.

2. To change the current time, click Change date and time.
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3. Select the Internet Time tab.

4. Click Change settings.

The Internet Time Settings window appears.

5. Select Synchronize with an Internet time server.

6. In the Server field, select your NTP server. Then click Update now.

7. Click OK to close the Internet Time Settings window.

8. Click OK to close the Date and Time window.

Select

Select your
NTP Server

this option
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Installing the Avaya AES TSAPI Client 

The CTI Client software must be installed on the NICE Perform eXpress. Prior to installing the 
client software, the CTI must be prepared for NICE Perform eXpress. See Preparing the CTI for 
NICE Perform eXpress on page 149.

Contents

Installing Client Software on the NICE Perform eXpress............................................28

Setting the SNMP Community Name of the IP Phones to Public...............................30
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Installing Client Software on the NICE Perform eXpress
In an environment using the AES Server, install the Avaya Application Enablement Services 
(AES) TSAPI Client on the NICE Perform eXpress.

Before beginning this procedure, confirm that the CTI was prepared properly for NICE Perform 
eXpress. See Preparing the CTI for NICE Perform eXpress on page 149.

To install the Avaya AES TSAPI Client software:

1. Insert the AES TSAPI Client installation CD in the CD-ROM drive of the NICE Perform 
eXpressNICE Interactions Center. 

The Avaya AES TSAPI installation wizard starts.
Figure 3-1   Avaya AES TSAPI Installation Wizard - Setup

2. Click Next.

The Choose Destination Location window appears.

IMPORTANT
• The Avaya AES TSAPI Client installed on the NICE Perform eXpressNICE Interactions 

Center must be version 4.2.1, regardless of the Avaya AES Server version.
For further details, see the Integration Description Document (IDD).
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Figure 3-2   Choose Destination Location Window

3. Click Next. 

The TCP/IP Name Server Configuration window appears.
Figure 3-3   TCP/IP Name Server Configuration Window

4. To configure the TSAPI Service via the TCP/IP:

4.1. In the Host Name or IP address field, enter the IP address of the AES Server.

In the TCP Port field, leave the default value.

The Add to List button becomes enabled.

4.2. Click Add to List.

The IP address and port value appear in the Configured Telephony Services list 
box.

5. Click Next. 

The Avaya AES TSAPI Client software files are installed.

6. When the installation is complete, click Finish.
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Setting the SNMP Community Name of the IP Phones to 
Public

Avaya Firmware release 2.6 and above has created two issues regarding IP address resolution in a 
dynamic IP environment. These issues are relevant when the RAS Driver communicates with the 
Avaya IP phones either via the Push Interface or via the SNMP Protocol.

Avaya removed the default community name, public, as a security enhancement. As a result, the 
IP telephones do not respond to SNMP get messages, which means that the IP addresses cannot be 
resolved.

When the RAS Driver communicates with the Avaya IP phones via the SNMP protocol, the 
phones must have a defined community name.

In order to overcome this issue, you need to modify the 46XXsetting.txt file, which is on the 
TFTP Server. From the 46XXsetting.txt file, the IP phones download their Firmware in order to 
configure a default value for the SNMP Community string.

You can choose one of the following options:

• Set the community name of the IP phones to public. This will in fact eliminate the Avaya 
security enhancement.

-or-

• Set the community name of both the IP phones and the NICE Interactions Center to a name of 
your choice, enabling only specific systems, such as the NICE Systems, to communicate with 
the IP phones.

The Avaya IP phone models that are affected are 4610SW, 4620SW, 4621SW and 4622SW.
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To set the SNMP community name of the IP phones to public:

1. From the TFTP Server, open the 46XXsetting.txt file.

2. Verify that the string SET SNMPSTRING does not have the pound sign (#), spaces or other 
characters before it, and that the full command is SET SNMPSTRING public, as shown 
below.

3. Save the 46XXsetting.txt file.

4. After modifying the 46XXsetting.txt file, you must restart the relevant IP phones in order for 
them to read the new settings.

Verify that the string does not have the pound 
sign, spaces or other characters before it.
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Installing NICE Perform eXpress

This section describes installing NICE Perform eXpress and activating your license. NICE 
Perform eXpress can be installed using the NICE Perform eXpress installation wizard or by 
running a silent installation.

If it becomes necessary at any time to reinstall NICE Perform eXpress, you may require a new 
license. See the Maintenance Guide for licensing details. 

If this is a migration from NiceCall Focus III or NiceUniverse 8.9, after installation, log in and 
activate your license. Do not configure your system at this time. See the Migrating from NiceCall 
Focus III and NiceUniverse 8.9 guide for further instructions.

Contents

Installing NICE Perform eXpress Software...................................................................34
Running the NICE Perform eXpress Installation Wizard............................................35
Running a Silent Installation.......................................................................................44

Integrating the Support Calendar into MS Outlook.....................................................50

First-Time Login..............................................................................................................52
First-Time Login with NICE Authentication.................................................................52
First-Time Login with Windows Authentication (Single Sign-On or SSO) ..................56
Switching between NICE Authentication and Window Authentication .......................59

First-Time Licensing: Automatic Activation ................................................................60
License Information and Status..................................................................................61

Manually Activating or Updating a License .................................................................62
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Installing NICE Perform eXpress Software
NICE Perform eXpress can be installed using the Installation Wizard or by running a Silent 
Installation. Both installation processes install all NICE Perform eXpress components. This is the 
only installation required for NICE Perform eXpress.

During the installation process you will be required to supply a user account to be used by services 
at logon. This user account must have the following rights:

• Log on as service

• Log on as a batch job

• Act as part of the operating system

• Create a token object

• Replace a process-level token

• Manage auditing and security log

If the user account name you enter does not have all of the above rights, the installation process 
will automatically add them.

To run a Silent Installation, you prepare a config file using the template provided with your 
software. The same config file, with the same parameters, can be used for multiple NICE Perform 
eXpress installations.

• To use the Installation Wizard, see Running the NICE Perform eXpress Installation 
Wizard on page 35.

• To use the Silent Installation, see Running a Silent Installation on page 44.

WARNING
In a VoIP environment, or in a mixed environment where one environment is VoIP:

• All NICE Perform eXpress NICs that are not connected to the network must be disabled in 
the OS! 

• Verify that all installed NICs are configured to Auto Negotiation. Auto Negotiation ensures 
that the maximum speed will be used. 
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Running the NICE Perform eXpress Installation Wizard

The NICE Perform eXpress installation wizard takes you through the complete installation process 
with a few easy steps. This wizard installs all NICE Perform eXpress components. It is the only 
installation required for NICE Perform eXpress.

During the installation process, you might be requested to restart your machine. If this occurs, 
restart the machine. After restarting, the installation process will automatically continue from the 
correct point.

The installation software includes the Update Pack that was issued during General Availability. 
However, if an Update Pack is available on the NICE Software Download Center, this indicates 
that a newer Update Pack must be installed, as part of the installation process, see Step 6. 

After installation is complete, if a newer Update Pack is issued, see the Maintenance Guide for 
installation procedures.

To complete the following installation procedure, you will need the following:

• Access to the NICE Software Download Center. 

• The average number of expected interactions per day and the retention period, so that database 
sizes can be calculated automatically.

• A valid User ID with administrative privileges on this machine.

To install NICE Perform eXpress:

1. Ensure that all Microsoft management windows (gpedit.msc, services.msc, etc.) are closed.

2. Before you begin:

• If a CTI Client is required, confirm that it is installed.

• If you are using Tivoli Storage Manager (TSM) storage, confirm that the TSM client 
(version 5.5) is installed.

• If a Backup device is installed, confirm that its driver is installed and that it is enabled in 
the Device Manager.

• In a Windows Authentication (Single Sign-On or SSO) environment, NICE Perform 
eXpress must be installed on a server in the Domain.

3. If your local language is not English, set the Regional Language on the NICE Perform 
eXpress machine to English. You will be instructed to reset the language after the installation. 
For instructions, see Setting the Regional Language on page 201.

4. On your local hard drive, create a folder dedicated to NICE Perform eXpress software. Do not 
create this folder on your desktop! 

Correct Example: D:\NICE Software

Incorrect Example: C:\Documents and Settings\Desktop\NICE Software

NOTE: If it becomes necessary at any time to reinstall NICE Perform eXpress, you 
may require a new license. See the Maintenance Guide for licensing details. 
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5. From the NICE Software Download Center, copy the NICE Perform eXpress installation 
folder to the folder created in Step 4.

6. Update Packs are NUP files. If an Update Pack for NICE Perform eXpress 3.0 resides on the 
NICE Software Download Center do the following:

a. From its location on your local hard drive, navigate to:

...\NICE Perform eXpress\NPX3.0\Installation\<version number>\NPX

b. If there is a folder called Updates, open it and delete its contents. If not, add a new folder 
and name it Updates.

c. From the NICE Software Download Center, copy the Update Pack to the Updates 
folder. There should be only one NUP file in the Updates folder; each Update Pack 
includes all previous Update Packs.

7. From its location on your local hard drive, navigate to

...\NICE Perform eXpress\NPX3.0\Installation\<version number>\NPX

8. Double-click Setup.exe.

The Security Warning window or the NICE Perform eXpress installation wizard appears.

9. If the Security Warning appears, click Run. Then the NICE Perform eXpress installation 
wizard appears. 

10. In the NICE Perform eXpress installation wizard click Next.

Updates

Click Run to start the wizard
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The License Agreement window appears.

11. Select I accept the licensing terms and conditions. Then click Next.

The Target Installation Directories window appears.

12. Accept the default locations for the NICE Software and SQL Server installation folders. If 
you must change a location, click the relevant Browse button and select the new location.

If an SQL Server was installed prior to the NICE Perform eXpress installation, the SQL 
Server Installation Folder will be read-only. 

The locations for the Recording Components appear for informative purposes only. They 
are read-only and cannot be changed.

13. Click Next. 
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The Database Configuration window appears.

14. To change the default location for the databases, click Browse.

15. In the Database Size Calculator area, you can define database retention period using these 
guidelines:

The Database size is automatically calculated. It appears near the bottom of the window. It is 
determined by the number of interactions you expect per day and the retention period. The 
default is 8100 interactions per day.

Example: You have 10000 interactions one day, and only 5000 interactions the following day. 
All interactions will be recorded, since the average is less than 8100 per day. 

You can select one of the defaults or define a customized retention period. Options are as 
follows:

• 2 Year Retention - database size for 2 years with 8100 interactions per day is shown

• 10 Year Retention - database size for 10 years with 8100 interactions per day is shown

• Custom Retention - The Expected Interactions per Day and Year Retention fields 
become active. Enter a value in each. The database size is calculated and shown.

16. Click Next.

NOTE: A red exclamation mark indicates that there is insufficient space available for 
the databases. Increase the available space on the disk or decrease the retention in the 
Database Size Calculator area.

Calculated database size
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The Log On As window appears.

17. In the Domain\User field, enter a valid user with administrative privileges on this machine 
using these guidelines:

• If you are required to use your full domain name, enter your full domain name 
(servername\username). 

Example: NICE_Systems\NICE_Services 

• If you are within your site’s domain, you can enter only the username. 

Example: NICE_Services

18. Enter the Password for the Log On user.

19. If a red exclamation mark appears next to the Password with the message User must 
change password at next logon, see Changing Administrator Password on page 42.
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20. Click Install. 

The Installation Process window appears and installation begins. 

This procedure can take several hours depending on your database size. 

During the installation process, a message might appear asking you to restart your 
machine. If this occurs, click OK and restart your machine. After restart, the installation 
will automatically continue from the correct point. 

See the Note below and refer to the displayed Remaining Time in the lower right-hand 
corner of the window. 

If an SQL server was installed prior to the NICE Perform eXpress installation, installation for 
it will not appear now. 

NOTE: If the user name you entered in the Log On As window does not have the Log 
On As Service privilege, a message appears. 

You have the following options:

• Yes - Log On As Service privileges are added to the user. Continue this 
procedure.

-or-

• No - The installation returns to the Log On As window so that you can enter a 
different user name. Repeat this procedure from Step 17.

Remaining Time
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21. When the entire installation process is complete, click Next.

The Setup Wizard Completed window appears.

22. Select Yes, I want to restart my computer now. Then click Finish. Your computer restarts.

NOTE: About 20 minutes into the installation process, you might receive one or several 
messages as follows. Click Continue Anyway or click Install as appears in the 
message.
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NICE Perform eXpress is installed. The following are added to your computer:

• A shortcut to NICE Perform eXpress is placed on your desktop.

• In the Start menu, the NICE Perform eXpress menu is added with access to various 
tools used for maintenance and troubleshooting. A list of tools can be found in the 
introduction to this guide.

• NICE Perform eXpress adds services to your computer:

Note: Services for Screen Recording, MML Logger and MML TrayIcon, are also 
installed. They are disabled and hidden until Screen Recording is enabled.

23. If your local language is not English, reset the Regional Language on the NICE Perform 
eXpress machine to your local language. See Setting the Regional Language on page 201.

24. To a schedule routine verifications of the NICE Perform eXpress system to your MS Outlook 
calendar, see Integrating the Support Calendar into MS Outlook on page 50.

25. Continue with First-Time Login on page 52.

Changing Administrator Password
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If, during the installation (Step 18 on page 39), a messages appears that User must change 
password at next logon, this indicates that the user’s properties are set to User must change 
password at next logon.

It is not necessary to stop the installation!

Do one of the following:

1. Change the user’s password: 

a. Open the Server Manager window, navigate to Configuration > Local Users and 
Groups > Users. Then right-click the user and select Set Password. Change the 
password.

b. Return to Step 18 on page 39 of the installation.

-or-

2. Reset the user’s logon properties:

Note: Do not choose this option if it interferes with your organization’s security policy.

a. Open the Server Manager window, navigate to Configuration > Local Users and 
Groups > Users. Then right-click the user and select Properties.

b. Clear User must change password at next logon.

c. Select the following:

• User cannot change password

Incorrect
Options

Select these
Options
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• Password never expires

d. Return to Step 18 on page 39 of the installation.

Running a Silent Installation

You can run a Silent Installation from a prepared config file instead of from the Installation 
wizard.

The installation software includes the Update Pack that was issued during General Availability. 
However, if an Update Pack is available on the NICE Software Download Center, this indicates 
that a newer Update Pack must be installed, as part of the installation process, see Step 6. 

After installation is complete, if a newer Update Pack is issued, see the Maintenance Guide for 
installation procedures.

During the installation process, the machine will restart itself. This is part of the normal procedure.

Advantages of a Silent Installation

• Parameters for the installation can be prepared beforehand and saved in a configuration file.

• The same configuration file, with the same parameters, can be used for multiple NICE 
Perform eXpress installations.

Your NICE Perform eXpress installation folder includes the following files for running a Silent 
Installation:

• Params.config - Configuration file with parameters required for the installation. Edit the 
values of these parameters directly in this file. Descriptions of each parameter appear in the 
Silent Install.bat file.

• Silent Install.bat - Run this file to install NICE Perform eXpress. This file also includes 
descriptions of all parameters required by the Params.config file. To see descriptions and 
default values, open it in a text editor.

• Silent UnInstall.bat - Run this file to uninstall NICE Perform eXpress. For instructions, see 
the Maintenance Guide.

After you run the Silent Installation, results appear in the FrameworkLogfile.txt file.

To run a silent installation:

1. Ensure that all Microsoft management windows (gpedit.msc, services.msc, etc.) are closed.

2. Before you begin:

• If a CTI Client is required, confirm that it is installed.

NOTE: If it becomes necessary at any time to reinstall NICE Perform eXpress, you 
may require a new license. See the Maintenance Guide for licensing details. 
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• If you are using Tivoli Storage Manager (TSM) storage, confirm that the TSM client 
(version 5.5) is installed.

• If a Backup device is installed, confirm that its driver is installed and that it is enabled in 
the Device Manager.

• In a Windows Authentication (Single Sign-On or SSO) environment, NICE Perform 
eXpress must be installed on a server in the Domain.

3. If your local language is not English, set the Regional Language on the NICE Perform 
eXpress machine to English. You will be instructed to reset the language after the installation. 
For instructions, see Setting the Regional Language on page 201.

4. On your local hard drive, create a folder dedicated to NICE Perform eXpress software. Do not 
create this folder on your desktop! 

Correct Example: D:\NICE Software

Incorrect Example: C:\Documents and Settings\Desktop\NICE Software

5. From the NICE Software Download Center, copy the NICE Perform eXpress installation 
folder to the folder created in Step 4. 

6. Update Packs are NUP files. If an Update Pack for NICE Perform eXpress 3.0 resides on the 
NICE Software Download Center do the following:

a. From its location on your local hard drive, navigate to

...\NICE Perform eXpress\NPX3.0\Installation\<version number>\NPX

b. If there is a folder called Updates, open it and delete its contents. If not, add a new folder 
and name it Updates.

c. From the NICE Software Download Center, copy the Update Pack to the Updates 
folder. There should be only one NUP file in the Updates folder; each Update Pack 
includes all previous Update Packs.

7. From its location on your local hard drive, navigate to

...\NICE Perform eXpress\NPX3.0\Installation\<version number>\NPX

Updates
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8. Open the Params.config file using a text editor.

9. Enter or edit the default values for the following parameters:

Parameter Default Value Description

 TARGETDIR D:\Program Files\NICE 
Systems\NICE Perform 
eXpress

Directory for the NICE Perform 
eXpress installation files.

TARGETDIRSQL D:\Program Files\Microsoft 
SQL Server 2008

Directory for the SQL Server 
installation files.

TARGETDIRDB D:\Program Files\NICE 
Systems\NICE Perform 
eXpress\DB

Directory for the database data 
and log files.

USERNAME No default value provided Username used by services to 
log on.
If this user does not have all of 
the required rights, they will 
automatically be added to the 
user.

PASSWORD No default value provided Password for USERNAME.

DOMAIN No default value provided Domain name for USERNAME.

ADMIN_SERVER_HOST localhost Location of the System 
Administrator component. This 
is always localhost and should 
not be changed.

NICE_INTERACTIONS_
SIZE_PLACE_HOLDER 

10209 MB Size of the nice_interactions 
database
The default value is based on 
2 year retention and 8100 calls 
per day.

Edit these
parameters
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10. Save and close the Params.config file.

11. From its location on your local hard drive, open the NICE Perform eXpress installation 
folder. Then double-click Silent Install.bat to run the installation.

12. The installation starts. About 20 minutes into the installation process, you might receive one or 
several messages as follows. Click Continue Anyway or click Install as appears in the 
message.

There is no notification that the installation has started or finished.

13. Depending on your database size, this procedure can take several hours. When installation is 
complete, you will be able to verify the installation in the log file. The log file is located at: 

Windows 2008: C:\Users\<USERNAME>\AppData\Local\NICE Perform 
eXpress\FrameworkLogfile.txt

NICE_INTERACTIONS_
LOG_SIZE_PLACE_HO
LDER

10% of the 
nice_interactions database 
size

Size of the nice_interactions 
log file

NICE_RULE_SIZE_PLA
CE_HOLDER

1991 MB Size of the nice_rule database 
The default value is based on 
2 year retention and 8100 calls 
per day 

NICE_RULE_LOG_SIZE
_PLACE_HOLDER

10% of the nice_rule 
database size

Size of the nice_rule log file

Parameter Default Value Description
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Windows XP: C:\Documents and Settings\<USERNAME>\Local Settings\Application 
Data\NICE Perform eXpress\FrameworkLogfile.txt

NICE Perform eXpress is installed.

The following are added to your computer:

• A shortcut to NICE Perform eXpress is placed on your desktop.

• In the Start menu, the NICE Perform eXpress menu is added with access to various 
tools used for maintenance and troubleshooting. A list of tools can be found in the 
introduction to this guide.

Sample Log File
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• NICE Perform eXpress adds services to your computer:

Note: Services for Screen Recording, MML Logger and MML TrayIcon, are also installed. 
They are disabled and hidden until Screen Recording is enabled.

14. If your local language is not English, reset the Regional Language on the NICE Perform 
eXpress machine to your local language. For instructions, see Setting the Regional Language 
on page 201.

15. Restart the NICE Perform eXpress machine.

16. To a schedule routine verifications of the NICE Perform eXpress system to your MS Outlook 
calendar, see Integrating the Support Calendar into MS Outlook on page 50.

17. Continue with First-Time Login on page 52.

To uninstall NICE Perform eXpress, see the Maintenance Guide. 
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Integrating the Support Calendar into MS Outlook

You can integrate the Support Calendar into MS Outlook so that reminders for the necessary 
maintenance checks appear in the Calendar application. An eXpress Support Calendar.rar file 
is included in the NICE Perform eXpress installation. You extract this RAR file and then import it 
into MS Outlook.

For details of what is included in the Support Calendar, see the Maintenance Guide.

To integrate the Support Calendar into MS Outlook:

1. On the NICE Perform eXpress machine, navigate to the installation folder, and extract the 
eXpress Support Calendar.rar file to the hard drive. This RAR file contains an eXpress 
Support Calendar.pst file.

2. Copy the eXpress Support Calendar.pst file to the hard drive of the machine that runs MS 
Outlook.

3. Open MS Outlook, and from the File menu, select Import and Export.

The Import and Export Wizard starts.

4. Click Next.

The Import a File window appears.
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5. Select Personal Folder File (.pst) from the list, and click Next.

The Import Personal Folders window appears.

6. In the File to import field, click Browse, and select the eXpress Support Calendar.pst file 
that you extracted in Step 1 on page 50.

7. Click Next.

The Import Personal Folders window appears.

8. Click Finish.

The reminders for the Support Calendar are imported into Outlook.
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First-Time Login 
If your NICE Perform eXpress is not installed in English, use the procedures in Localization - 
Language Support on page 199 in place of the following procedure.

In a NICE Authentication environment, continue with First-Time Login with NICE 
Authentication on page 52.

-or-

In a Windows Authentication (Single Sign-On or SSO) environment, continue with 
First-Time Login with Windows Authentication (Single Sign-On or SSO) on page 56.

First-Time Login with NICE Authentication

The first time you log in to NICE Perform eXpress you will use the default name nice, and the 
default password nice. You will be instructed to change the default password. Have prepared a 
new password and record it in a safe place. Passwords are case-sensitive.

To create a different user for login, see Managing Users and Groups on page 113.

If you experience any problems opening NICE Perform eXpress, see Configuring Internet 
Explorer for NICE Perform eXpress on page 212.

To log in to NICE Perform eXpress:

1. To open NICE Perform eXpress on the local machine, on the desktop, double-click the NICE 
Perform eXpress icon.

-or-

(from a remote server) Open an Internet Explorer window and enter the following URL: 
http://ServerName/npx 

Where ServerName is the name of the server where NICE Perform eXpress is installed. 
Example: NICE Perform eXpress is installed on a server named server1, the URL will be: 
http://server1/npx 

NOTE: You can change your NICE Perform eXpress system from NICE Authentication 
to Windows Authentication, or back again, after initial log in. In this case, the procedure 
varies slightly to accommodate existing users. See the Maintenance Guide for details.
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The NICE Perform eXpress Welcome window appears. 

If you experience any problems opening NICE Perform eXpress, see Configuring Internet 
Explorer for NICE Perform eXpress on page 212.

2. Log in as follows:

a. In the Name field, enter nice.

b. In the Password field, enter nice.

c. Click Login.

The Change Password window appears.

Note: If you have already logged in using the Central Administration on this same 
machine, the password was already changed and this window will not appear. Use the 
same password as for the Central Administration and continue with Step 4.
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3. Complete this window as follows:

a. In the Password field, enter nice.

b. In the New Password field, enter a new password. Passwords are case-sensitive. 

c. In the Confirm New Password field, re-enter exactly the same New Password.

d. Click Change Password.

The NICE Perform eXpress Welcome window reappears. 

4. Log in as follows:

a. In the Name field, enter nice.

b. In the Password field, enter the new password defined in Step 3.

c. Click Login.
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NICE Perform eXpress opens.

NICE Perform eXpress is installed with a default (Provisional) license that has five recording 
channels and is valid for three months. 

5. To view the license expiration date, click the System Settings tab. The Licensing section 
displays the License Information and Expiration Date.

6. If you have direct internet access from the NICE Perform eXpress machine, continue with 
First-Time Licensing: Automatic Activation on page 60. 

-or-

If you do not have direct internet access from the NICE Perform eXpress machine, continue 
with Manually Activating or Updating a License on page 62.

Automatic Activations appears only
when the License status is Provisional

Provisional
License
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First-Time Login with Windows Authentication (Single Sign-On or SSO) 

The default authentication mode for NICE Perform eXpress is NICE Authentication. To log in to 
NICE Perform eXpress for the first time using Windows Authentication (Single Sign-On or SSO), 
use the Security Configuration Tool, as describe below to switch authentication modes.

As part of this procedure, you can define a default domain for all new users.

To switch to Windows Authentication and log in:

1. On the NICE Perform eXpress machine, from the Start menu, select All Programs > NICE 
Perform eXpress > Tools > Security Configuration Tool.

-or-

Open the Security Configuration Tool from its location on your hard drive:

D:\Program Files\NICE Systems\NICE Perform eXpress\Tools\Security Configuration 
Tool

The Security Configuration Tool appears. 

2. For Authentication Mode, select Windows.

IMPORTANT 
After you switch to Windows Authentication, you must log off of Windows and log in again using 
your Superuser OS Login, before you can open up NICE Perform eXpress. This is done as part 
of the procedure below.
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The Security Configuration Tool changes to reflect the required information.

3. In the Available Domains list, do the following:

a. Enter the name of each domain on an empty line. Only NetBIOS domain names are 
supported.

b. Optional. Select one domain as the Default domain. All users who are created without a 
domain will automatically be added to the default domain.

4. In the User Settings area, do the following:

a. Enter the Windows user name for the Superuser Login. The Superuser will not appear in 
the NICE Perform eXpress User Administration or be seen by any other NICE Perform 
eXpress user. The Superuser must be a Domain User.

b. Select a Superuser domain for the Superuser. To add a domain to this list, add it to the 
Available Domains list.

5. Optional. To automatically assign a domain to existing users who do not have a domain, select 
Apply Default Domain.

6. Click Apply to change the authentication mode.

7. Click Exit to exit the tool.

You NICE Perform eXpress is now in Windows Authentication mode. 

• If you need to switch back to NICE Authentication, see the Maintenance Guide. 

• If you have any trouble with the Security Configuration Tool, log files are located at:

D:\Program Files\NICE Systems\NICE Perform eXpress\Tools\Security 
Configuration Tool\Logs

8. Log off of Windows and log in again using your Superuser OS Login (Windows 
Authentication).
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Continue this procedure for first-time login.

9. On the desktop, double-click the NICE Perform eXpress icon.

-or-

(from a remote server) Open an Internet Explorer window and enter the following URL: 
http://ServerName/npx 

Where ServerName is the name of the server where NICE Perform eXpress is installed. 
Example: NICE Perform eXpress is installed on a server named server1, the URL will be: 
http://server1/npx 

NICE Perform eXpress opens. If NICE Perform eXpress does not open, confirm that you are 
correctly logged in to Windows with the Superuser OS Login.

NICE Perform eXpress is installed with a default (Provisional) license that has five recording 
channels and is valid for three months. 

Automatic Activations appears only
when the License status is Provisional

Provisional
License
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10. To view the license expiration date, click the System Settings tab. The Licensing section 
displays the License Information and Expiration Date.

11. If you have direct internet access from the NICE Perform eXpress machine, continue with 
First-Time Licensing: Automatic Activation on page 60. 

-or-

If you do not have direct internet access from the NICE Perform eXpress machine, continue 
with Manually Activating or Updating a License on page 62.

Switching between NICE Authentication and Window Authentication

Switching between NICE Authentication and Windows Authentication (also know as Single 
Sign-On or SSO) or back again is a simple process, however there are some considerations and 
repercussions to be aware of. For complete details, see Changing Authentication Mode in the 
Maintenance Guide before proceeding.
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First-Time Licensing: Automatic Activation
Your NICE Perform eXpress is installed with a default license that is valid for recording five 
channels for a three month period. The status of this license is Provisional. You must activate a 
new license before the temporary one reaches its expiration date. There are two ways to activate a 
license.

• If you have direct internet access from the NICE Perform eXpress machine, use Automatic 
Activation. This option is only available while your license status is Provisional. 

• If you do not have direct internet access from the NICE Perform eXpress machine, use 
Manual Activation / Update. For instructions, see Manually Activating or Updating a 
License on page 62.

You will require a valid Product Key to complete this process. 

For a description of license states, see License Information and Status on page 61.

To activate a First-Time License:

1. In System Management, click the System Settings tab.

The License Information shows the status as Provisional, with an expiration date. You will 
need to update the license to a permanent one before this expiration date is reached.

Automatic Activations appears only
when the License status is Provisional

Provisional
License
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2. In the Automatic Activation area, enter a valid Product Key. Then click Activate.

The license is updated to Activated. You have completed this procedure.

3. To begin configuring your NICE Perform eXpress, click Sign out. Then log in again and all 
your tabs will appear.

License Information and Status

The License Information field indicates the current state of your license. License states can be one 
of the following:

• Provisional - This is a temporary license. Your initial default license is provisional. 
A Provisional license is valid for recording five channels for a three month period.

• Activated - The current license is valid. 

• Expired - Occurs in the following scenarios (Recording continues, however the NICE 
Perform eXpress interface is locked.):

• The current license is past its expiration date.

• NICE Perform eXpress detected a change in hardware on the NICE Perform eXpress 
machine. A new Product Key is required to activate a new license.

• NICE Perform eXpress was installed on a Virtual Machine.

• The license was activated from a remote machine.

• Unknown - A problem was encountered that does not classify as expired. Recording 
continues, however the NICE Perform eXpress interface is locked.

• Locked - Indicates a communications problem between the interface and the license. 
Recording continues, however the NICE Perform eXpress interface is locked.

Activated License

IMPORTANT 
If you are migrating from NiceCall Focus III or NiceUniverse 8.9, do not configure your 
system at this time. See the Migrating from NiceCall Focus III and NiceUniverse 8.9 guide for 
further instructions.
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Manually Activating or Updating a License
Use this procedure in the following scenarios:

• You are activating a first-time license (Provisional) and do not have direct internet access from 
the NICE Perform eXpress machine.

• You are updating an existing license.

In this procedure you will be instructed on how to generate a License Information File from your 
NICE Perform eXpress. Then you will be instructed how to use this License Information File to 
obtain a valid License Activation File. You will require the following:

• Access to a machine with internet access to NICE’s ExtraNICE site. This does not have to be 
the same machine as the NICE Perform eXpress machine.

• A valid ExtraNICE Username and Password.

• A valid Product Key to obtain your License Activation File from the ExtraNICE.

For a description of license states, see License Information and Status on page 61.

To manually activate or update a License:

1. In System Management, click the System Settings tab.

Generate

Automatic Activations appears only
when the License status is Provisional
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2. In the Manual Activation / Update area, click Generate.

The File Download window appears with the License Information File.

3. Click Save to save the License Information File.

The Save As window appears.

4. Select a location for the License Information File (license.c2v). Then click Save. You will 
need this file to receive your License Activation File. 

The Download Complete window appears. 
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5. Click Close.

6. Transfer the license.c2v file to a machine with Internet access to NICE’s ExtraNICE site.

7. On the machine with Internet access to the ExtraNICE do the following:

a. Open an Internet Explorer window and enter the following URL:

http://www.extranice.com/EIS/OnlineServices/LicenseActivation/Pages/default.aspx

If you have not previously logged in to ExtraNICE, the following window appears.

b. Enter a valid ExtraNICE Username and Password. Then click Log On to ExtraNICE.

The NICE Perform eXpress License Activation window appears.

c. Click Browse and select the License Information File (license.c2v) from Step 6.

d. Enter a valid Product Key. Then click Activate.

e. Download the corresponding License Activation File (license.v2c). 

f. Transfer the License Activation file to the NICE Perform eXpress machine.
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8. On the NICE Perform eXpress machine, click Browse and select the License Activation File 
(license.v2c).

9. Click Activate.

The license is updated. 

10. Click Sign out. Then log in again and all the tabs will appear.

IMPORTANT 
If you are migrating from NiceCall Focus III or NiceUniverse 8.9, do not configure your 
system at this time. See the Migrating from NiceCall Focus III and NiceUniverse 8.9 guide for 
further instructions.
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5

Configuring NICE Perform eXpress

The Avaya TSAPI Passive VoIP Dynamic IP telephony environment is comprised of the 
following: 

In the following procedures, you will define the following:

• CTI and recording parameters. You can use predefined parameters from the Central 
Administration

• VoIP channels 

• Devices for monitoring. You can import a previously prepared file

• Map monitored devices to channels for recording. You can import a previously prepared file

• Data storage and retention rules

• Quality Management: Define screen recording and Quality Management rules

Contents

Making the Most of NICE Perform eXpress..................................................................68

Procedure 1: Choosing the Telephony Environment ..................................................73

Procedure 2: Defining CTI and Recording ...................................................................75

Procedure 3: Configuring Channel Mapping ...............................................................83

Procedure 4: Configuring Storage ................................................................................91

Configuring Backup without Storage .........................................................................103

Quality Management: Defining Screen Recording QM Rules...................................106

Telephony CTI Type Avaya CM

CTI Interface AES TSAPI

Reporting Type CTI

Recording Type Passive VoIP



68 Chapter 5: Configuring NICE Perform eXpress

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Making the Most of NICE Perform eXpress

Making the Most of NICE Perform eXpress
Before you begin configuring your NICE Perform eXpress, determine if any or all of the following 
features apply to your system. 

Note that these sections are not procedures. They provide an overview of each feature. Use the 
regular configuration procedures beginning with Procedure 1: Choosing the Telephony 
Environment on page 73. You will be directed when necessary to alter course for these features.

• Configuration Workflow: Save, Apply, Next, or Done? on page 68 

• How to Work with a Mixed Environment on page 70 

• How to Use Predefined CTI and Storage Settings on page 71

• How to Import Channel Mapping Definitions on page 72

Configuration Workflow: Save, Apply, Next, or Done?

NICE Perform eXpress Configuration is divided into four separate steps. Each one is on its own 
tabbed page. The application is designed to work much like a wizard; during first-time setup you 
must click Next at the bottom of each tab to advance to the next tab.

Once you have advanced to a tab, or when modifying an existing configuration, you can, at any 
time, return to a previous tab by clicking the tab. 

At the bottom of each tabbed page you will see one, two, or three of the following buttons:

-or-

The first time you configure Storage and Rules you will see the following:
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The function of each button is determined by the page on which it appears, as follows:

Configuration Buttons and their Functions

Button Function Is Recording Interrupted?

Save Saves data entered on this tab. Does not make it 
active in the system.

IMPORTANT! You must click Apply to activate 
changes in the system.

No

Next Same as Save. 

Also advances to the next tab.

Recording is interrupted 
when a second environment is 
added on the Telephony 
Environment tab.

Apply Saves and activates changes in the system. 

Note that when you click Apply, all changes 
from all tabs are applied. One of the sections 
can cause recording to be interrupted, even if 
the change is not on the current tab.

In a Mixed Environment, when recording is 
interrupted, it is interrupted on both 
environments.

Recording is not interrupted when changes are 
made in the following sections:

• Monitored Devices

• Channel Mapping

• Business Data Settings 

• Storage Settings (Storage services restart; 
recording is not interrupted)

• Quality Management Settings

• D-Channels (extension-side environments)

Recording is interrupted in 
an active system when changes 
are made in the following 
sections: 

• Telephony CTI Settings

• Recording Settings

• Screen Recordings 
Settings

• Backup Settings

• IP Addresses for Devices 
(Dynamic IP environments)

• Device Mapping 
(Nortel CDR and 
Symposium environments)

• NEQT to Trunk Group 
Mapping (Alcatel TSAPI 
TDM Trunk-side 
environments)

Done Appears only on the Storage and Rules tab 
during first-time configuration. In a Mixed 
Environment, appears only when defining the 
first environment.

Saves data entered on this tab and applies all 
changes from all tabs in your system, enabling 
recording to begin.

After clicking Done, the User Administration 
opens so you can add Users to your system.

n/a

Why? Since Done only appears 
the very first time, before 
recording has started, recording 
cannot be interrupted.



70 Chapter 5: Configuring NICE Perform eXpress

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Making the Most of NICE Perform eXpress

How to Work with a Mixed Environment

A Mixed Environment consists of two different Telephony Environments that are installed 
side-by-side on the same NICE Perform eXpress machine. They do not have to have the same CTI 
or Recording Type. 

Example: An Avaya TSAPI TDM Extension-Side environment can be installed side-by-side with a 
Line Signaling Based Trunk-Side environment.

Active VoIP environments cannot be part of a mixed environment. Active VoIP environments can 
only be installed alone.

In a mixed environment, the following applies:

• CTI and Recording definitions are defined separately for each environment.

• The number of Licensed Channels are shared by both environments. 

Example: If you have 30 channels in your license and configure one environment with 24 
channels, only 6 channels will be available for the second environment.

• Channel Mapping definitions are defined separately for each environment.

• Storage devices are shared by both environments and defined only once.

• Quality Management rules are shared by both environments and defined only once. 

• Business Data fields that are used by one environment, become unavailable to the second 
environment. 

Example: If both 120 text fields are assigned to one environment, there will not be any 120 
text fields available for the second environment.

• During Channel Mapping, sequential channel numbers are automatically assigned across 
both environments as channels are added. 

Example of sequential channels:

In Telephony Environment A, you define 10 channels. They will be numbered Channels 1 - 10.

In Telephony Environment B, you define 10 channels. They will be numbered Channels 11 - 20.

In Telephony Environment A, you add 10 more channels. These will be Channels 21 - 30.

Thus, Telephony Environment A will have 20 channels numbered 1-10, 21-30.

To install and configure a mixed environment, work with the guide for each environment. 

IMPORTANT 
In a Mixed Environment, if you make changes that temporarily interrupt recording, recording will 
be interrupted in both environments.
This is important when a second environment is added at a site where one environment is 
already installed and recording.
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Workflow for Configuring two Telephony Environments

1. Select Telephony Environment A.

2. Define CTI Settings for Telephony Environment A.

3. Define Recording Settings for Telephony Environment A.

4. Optional. Define Business Data for Telephony Environment A.

5. Define Channel Mapping for Telephony Environment A.

6. Optional. Define Storage and Rules used by both Telephony Environments A and B.

7. Optional. Define Quality Management rules used by both Telephony Environments A and B.

8. Select Telephony Environment B.

9. Define CTI Settings for Telephony Environment B.

10. Define Recording Settings for Telephony Environment B.

11. Optional. Define Business Data for Telephony Environment B.

12. Define Channel Mapping for Telephony Environment B.

Begin with Procedure 1: Choosing the Telephony Environment on page 73.

How to Use Predefined CTI and Storage Settings 

Organizations with several NICE Perform eXpress sites can install and use the NICE Perform 
eXpress Central Administration. Using Central Administration you can predefine CTI settings 
and Storage settings making them accessible at all your NICE Perform sites.

Here’s how it works:

1. Central Administration is installed on top of one of your NICE Perform eXpress sites.

2. An IT user creates several different sets of CTI and Storage settings, using the same 
parameters found in NICE Perform eXpress.

3. In the CTI and Recording tab and the Storage and Rules tab, you will have the option to 
select one of the predefined CTI settings or Storage settings respectively. The parameters from 
the Central Administration will be copied to your NICE Perform eXpress. You cannot change 
them. Changes can be made only in the Central Administration.

4. Recording Settings (channels, etc.) must be defined manually.

5. Business Data must be defined manually.

6. Channel Mapping must be defined automatically, manually, or imported from an external file.

7. Quality Management (QM) rules must be defined manually.

To install and use the Central Administration, see the Central Administration Guide.



72 Chapter 5: Configuring NICE Perform eXpress

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Making the Most of NICE Perform eXpress

How to Import Channel Mapping Definitions

NICE Perform eXpress provides the option to import all monitored device and channel mapping 
settings from an external Excel file. An easy-to-use template is provided for this purpose.

When you import monitored devices and channel mapping settings to a system that already has 
some definitions, existing definitions are not deleted. If a record is matched, according to the 
Device Name, then the new record overwrites the old one. If no match is found, the new record is 
added.

Workflow for Importing Channel Mapping Definitions

1. Create an Excel file following the instructions in Importing Channel Mapping and Users.

2. Save the file on your local hard drive.

3. In the Channel Mapping tab, click the Import File button.

4. A window opens where you select and import your file.

5. If a record is matched, according to the Device Name, the new record overwrites the old one.

-or-

If no match is found, the new record is added.
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Procedure 1: Choosing the Telephony Environment
The first step in configuring NICE Perform eXpress is to choose a Telephony Environment. 
A Telephony Environment consists of a CTI interface and a recording type.

In this procedure choose the Avaya TSAPI Passive VoIP Dynamic IP Telephony Environment.

If your NICE Perform eXpress is a mixed environment, this can be defined either first or second 
environment using these same procedures.

To choose a Telephony Environment:

1. Before you begin, confirm that the following have been completed:

• Installing Client Software on the NICE Perform eXpress on page 28

• Setting the SNMP Community Name of the IP Phones to Public on page 30

2. Log in to NICE Perform eXpress and select the Configuration application.

The Telephony Environment tab appears.

Do not click Add Telephony Environment! 

3. If you are configuring only one Telephony Environment, do the following:

a. From the Telephony Environment drop-down lists, select Avaya and then select Avaya 
TSAPI Passive VoIP Dynamic IP.

b. Click Next.

The CTI and Recording tab becomes enabled.

c. Continue with Procedure 2: Defining CTI and Recording on page 75.

4. In a Mixed Environment, if this is the first Telephony Environment, do the following:

a. From the Telephony Environment drop-down lists, select Avaya and then select Avaya 
TSAPI Passive VoIP Dynamic IP.
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b. Do not click Add Telephony Environment. 

c. Click Next.

The CTI and Recording tab becomes enabled.

d. Continue with Procedure 2: Defining CTI and Recording on page 75.

5. In a Mixed Environment, if this is the second Telephony Environment, do the following:

a. Click Add Telephony Environment.

A second Telephony Environment drop-down list appears.

b. In the second Telephony Environment row, select Avaya and then select Avaya TSAPI 
Passive VoIP Dynamic IP.

c. Click Next.

The CTI and Recording tab becomes enabled.

Avaya TSAPI Passive VoIP Dynamic IP parameters will appear in the lower portion of the 
CTI and Recording tab and of the Channel Mapping tab. Collapse the top section or scroll 
down to view them on each tab.

d. Continue with Procedure 2: Defining CTI and Recording on page 75.
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Procedure 2: Defining CTI and Recording
In this procedure define the following:

• Telephony CTI settings. You can use predefined parameters from the Central Administration. 

• Recording type and VoIP channels used for recording.

To define Telephony CTI Settings and VoIP Mapping parameters:

1. If the CTI and Recording tab is not active, select it now.

The CTI and Recording tab appears.

In a mixed environment, your Telephony Environment might be defined as the second 
Telephony Environment. If it does not appear at the top, scroll down to the correct 
environment or collapse the top section to view the correct Telephony Environment.

2. If you do not have a predefined Central Administration configuration, continue with Step 4.

3. To use a predefined Central Administration configuration, do the following:

a. From the Add Telephony CTI drop-down list, select the Telephony CTI definition. The 
Telephony CTI fields will be automatically filled. They are read-only and cannot be 
modified. 

b. Continue with Step 16.

4. Enter a Telephony CTI name. This will identify your CTI settings for reuse in your system.

VoIP 
Mapping

Telephony 
CTI 
Definition

Recording 
Definition

Telephony
Environment
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5. Define the remaining parameters in the Telephony CTI Settings section as follows.

6. Select one of the following VoIP Mapping Interfaces:

• Push (default)

• SNMP 

• AES SMS

• AES SMS + Push

• AES SMS + RAS

7. You will require TLink values for the following steps. TLink values must be supplied by an 
Avaya Administrator. To determine the TLink value, see Verifying the Secure/Non-Secure 
Tlink on page 167. 

8. Define the remaining parameters in the Telephony CTI Settings section as follows.

9. If needed, also define the parameters in the Advanced Telephony CTI Settings section as 
follows. 

Telephony CTI Settings Description/Values Default

TLink Server connection name. Enter the TLink 
value.

Login ID User Login for the TLink.

Password User Password for the TLink.

Advanced Telephony CTI 
Settings Description/Values Default

Use Warm Standby If your environment supports warm standby, 
select Yes. Additional parameters appear.

Note: If your site has Avaya Alternative 
TLink feature, leave this value as No. The 
Avaya Alternative Tlink feature is supported in 
the AES Server version 4.1 and above. AES 
TSAPI Client 4.2.1 automatically selects an 
alternate TLink (CTI link) when the preferred 
link is unavailable.

No

Standby TLink
Appears if Use Warm Standby = Yes

Secondary server connection name. This 
parameter is case-sensitive.

Standby Login ID
Appears if Use Warm Standby = Yes

User Login for the Standby TLink.

Standby Password
Appears if Use Warm Standby = Yes

Secondary Password for the Standby TLink.
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10. Define additional VoIP Mapping parameters as follows. 

11. Define Push VoIP Mapping Interface parameters as follows. Then continue with Step 16.

12. Define SNMP VoIP Mapping Interface parameters as follows. Then continue with Step 16.

Maximum Length of Internal 
Device

The maximum number of digits in an internal 
device. 

6

Treat Type 20 as Defines whether the Device Type assigned to 
Type 20 (IMPLICIT_PUBLIC) is trunk or 
station.

Trunk

Treat Type 40 as Defines whether the Device Type assigned to 
Type 40 (IMPLICIT_PRIVATE) is trunk or 
station.

Station

VoIP Mapping Interface Continue with...

Push Step 11

SNMP Step 12

AES SMS Step 13

AES SMS + Push Step 14

AES SMS + RAS Step 15

Advanced Telephony CTI 
Settings (Continued) Description/Values Default

IMPORTANT 
When you define VoIP Mapping parameters, you must also define IP Address for Devices. 
as described in Procedure 3: Configuring Channel Mapping on page 83.

VoIP Mapping Description/Values Default

Avaya Push API Port Port used by the web server in Avaya PUSH 
API.

62110

VoIP Mapping Description/Values Default

SNMP community public 
private 

This field is case-sensitive.

public
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13. Define AES SMS VoIP Mapping Interface parameters as follows. Then continue with Step 16.

VoIP Mapping Description/Values Default

AES Version Below 4.1 
4.1 and above

Below 4.1 

SMS host address IP Address of the secondary AES server.

SMS user name Username for the Avaya Communication 
Manager. 

Example: mylogin@cmserver

SMS password Defines the password for the Avaya 
Communication Manager.

Advanced VoIP Mapping  Description/Values Default

SMS request timeout in 
seconds

Timeout for SMS Web service requests. 30

Single map cycle • To set the mapping to occur only at 
startup, select Yes.

• To set the mapping to occur at specific 
intervals, select No. 

No

Wait between single 
mapping in minutes

The amount of time between each mapping 
cycle in minutes.

60

Use warm standby feature 
(SMS)

To define a Secondary SMS service, in case 
the Primary SMS Service is down, select 
Yes. Additional parameters appear.

No

Standby AES version
Appears if Use Warm Standby = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 
Below 4.1 
4.1 and above

Below 4.1

Standby SMS host address
Appears if Use Warm Standby = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 

Standby SMS user name
Appears if Use Warm Standby = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

Standby SMS password
Appears if Use Warm Standby = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

Standby SMS request 
timeout in Seconds
Appears if Use Warm Standby = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

30
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14. Define AES SMS + Push VoIP Mapping Interface parameters as follows. Then continue with 
Step 16. 

VoIP Mapping Description/Values Default

AES Version Below 4.1 
4.1 and above

Below 4.1 

SMS host address IP Address of the secondary AES server.

SMS user name Username for the Avaya Communication 
Manager. 

Example: mylogin@cmserver

SMS password Defines the password for the Avaya 
Communication Manager.

Avaya Push API Port Port used by the web server in Avaya PUSH 
API.

62110

Advanced VoIP Mapping  Description/Values Default

SMS request timeout in 
seconds

Timeout for SMS Web service requests. 30

Single map cycle • To set the mapping to occur only at 
startup, select Yes.

• To set the mapping to occur at specific 
intervals, select No. 

No

Wait between single 
mapping in minutes

The amount of time between each mapping 
cycle in minutes.

60

Use warm standby feature 
(SMS)

To define a Secondary SMS Service, in case 
the primary is down, select Yes. Then 
define the Standby SMS parameters below.

No

Standby AES version
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 
Below 4.1 
4.1 and above

Below 4.1

Standby SMS host address
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 

Standby SMS user name
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.
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15. Define AES SMS + RAS VoIP Mapping Interface parameters as follows. Then continue with 
Step 16. 

Standby SMS password
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

Standby SMS request 
timeout in Seconds
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

30

VoIP Mapping Description/Values Default

GateKeeper 1 Interception IP address 000.000.000.0
00

GateKeeper 2 Interception IP address 000.000.000.0
00

GateKeeper 3 Interception IP address 000.000.000.0
00

AES Version Below 4.1 
4.1 and above

Below 4.1 

SMS host address IP Address of the secondary AES server.

SMS user name Username for the Avaya Communication 
Manager. 

Example: mylogin@cmserver

SMS password Defines the password for the Avaya 
Communication Manager.

Advanced VoIP Mapping  Description/Values Default

SMS request timeout in 
seconds

Timeout for SMS Web service requests. 30

Single map cycle • To set the mapping to occur only at 
startup, select Yes.

• To set the mapping to occur at specific 
intervals, select No. 

No

Wait between single 
mapping in minutes

The amount of time between each mapping 
cycle in minutes.

60

Advanced VoIP Mapping 
(Continued) Description/Values Default
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16. NIC for Sniffing is a list of your network connections. Select the NIC that will be used for 
audio.

17. In the Configured Channels field, enter the number of channels used for this VoIP 
environment.

The Licensed Channels field shows the total channels available according to your license. If 
you have already assigned channels to other telephony environments, the number in the 
Configured Channels field will reflect this difference.

Example: You have 30 channels in your license (Licensed Channels). You are defining two 
telephony environments. Each with 15 channels. If the first telephony environment was already 
defined, you will only see the 15 remaining channels in the Configured Channels field. 

18. To define Business Data, see Adding Business Data (Additional CTI Fields) on page 171.

19. Scroll down and click one of the following:

Use warm standby feature 
(SMS)

To define a Secondary SMS service, in case 
the Primary SMS Service is down, select 
Yes. Additional parameters appear.

No

Standby AES version
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 
Below 4.1 
4.1 and above

Below 4.1

Standby SMS host address
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field. 

Standby SMS user name
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

Standby SMS password
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

Standby SMS request 
timeout in Seconds
Appears if Use warm standby 
feature = Yes

If Use warm standby feature (SMS) is 
defined as Yes, define this field.

30

Advanced VoIP Mapping Description/Values Default
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TIP: To return to this or a previous tab, just click the tab.

20. Continue with Procedure 3: Configuring Channel Mapping on page 83.

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! After all changes have been save, you must click Apply to 
activate changes in the system.

• Next Same as Save. 

After clicking Next, the Channel Mapping tab appears.

• Apply Saves and activates changes in the system. 

If changes are made to the Business Data section only, recording is not 
interrupted. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Telephony CTI Settings

• Recording Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.
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Procedure 3: Configuring Channel Mapping
In order for NICE Perform eXpress to gather all relevant information, all devices must be defined 
as monitored devices, even if they are not recorded. All devices that will be recorded must also be 
mapped to channels.

Monitored Devices and Channel Mapping can be configured in one of the following ways:

• Automatic Channel Mapping - Define the Monitored Devices and then simply click the 
Automatic Channel Mapping button. Channel Mapping assignments will be automatic and the 
Channel Mapping section will be filled. Use the procedure in this section. 

• Importing Definitions - Create an Excel sheet with Channel Mapping definitions and import 
it into your system. NICE Perform eXpress provides a template for this purpose. If you have 
such a file, proceed to Importing Channel Mapping on page 88 instead of the procedure in 
this section. This option also defines the Monitored Devices section.

• Manually - Enter Monitored Devices and Channel Mapping definitions directly into the 
appropriate sections of the Channel Mapping tab. Use the procedure in this section.

In this procedure you will do the following:

1. Define all CTI Interface devices for monitoring. The following devices can be monitored: 

• Extension

• ACD (hunt group)

• VDN

• IVR

ACD, VDN, and IVR devices do not get recorded. However, they must be monitored in order 
to obtain information required by NICE Perform eXpress.

2. Define all IP addresses for VoIP Mapping devices.

3. Define Channel Mapping. Map all extensions to channels for recording. 

In a Mixed Environment, sequential channel numbers are automatically assigned across both 
environments as channels are added. 

EXAMPLE: 
Sequential channels:
In Telephony Environment A, you define 10 channels. They will be numbered Channels 1 - 10.
In Telephony Environment B, you define 10 channels. They will be numbered Channels 11 - 20.
In Telephony Environment A, you add 10 more channels. They will be numbered Channels 
21 - 30.
Thus, Telephony Environment A will have 20 channels numbered 1-10, 21-30.
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Tips about Automatic Channel Mapping 

The following are the rules by which Automatic Channel Mapping operates.

• Automatic Channel Mapping will not change existing mapping definitions. Channels that were 
previously mapped will retain their original mapping and be passed over. If you want a 
specific device mapped to a specific channel, map it before implementing Automatic Channel 
Mapping.

Example: You have 20 channels. Channel 4 is already mapped. Automatic Channel Mapping 
will map to channels 1 - 3 and 5 - 20.

• According to the order in which they appear, each device that can be mapped, will be mapped 
to the next available channel. 

Example: You defined 20 monitored devices. Devices 1 - 5 are not recorded, only monitored. 
Automatic Channel Mapping will map only devices 6 - 20.

• If there are more devices than available channels, devices will be mapped in the order in which 
they appear until all channels are mapped. 

Example: You have 20 devices and 15 unmapped channels. The first 15 devices will be 
mapped to channels. The remaining 5 devices will not be mapped.

• If you delete a device, the remaining devices will retain their original mappings. The channel 
to which the deleted device was mapped will remain empty and available to be mapped 
manually or by the next Automatic Channel Mapping. 

Example: Devices 1 - 10 are mapped to channels 1 - 10. You delete device 1. Devices 2 - 10 
will remain mapped to channels 2 - 10. Channel 1 is now available for mapping.

• Each time you click Automatic Channel Mapping, any unmapped devices will be mapped to 
the next available channels. 

Example: Due to previous mapping and changes in devices, channels 1, 5, and 6 remain 
available. If you add more devices and then click Automatic Channel Mapping, the first three 
unmapped devices will be mapped to channels 1, 5, and 6 respectively.

To define Devices and Channel Mapping:

1. Select the Channel Mapping tab.
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In a mixed environment, your Telephony Environment might be defined as the second 
Telephony Environment. If it does not appear at the top, scroll down to the correct 
environment or collapse the top section to view the correct Telephony Environment.

2. To import Channel Mapping configurations from an Import file, use the procedure in 
Importing Channel Mapping on page 88 in place of this one.

3. In the Monitored Devices section, define all devices being monitored and/or recorded by the 
CTI Interface as follows:

a. In the Enter Number of Range field, enter a range or single values separated by 
commas. A range cannot contain more than 100 devices.

Example: 1-10,20,25-30 or 200-299,300-399

b. In the Select Type field, select the type of device: Extension, IVR, ACD, or VDN.

c. Click Add . The devices are added to the list.

All the devices will automatically be monitored. Only Extension devices can be recorded.

4. Repeat Step 3 until all devices are added.

5. If you are not defining IP Addresses for VoIP Mapping devices, continue with Step 8.

Monitored
Devices

Channel
Mapping

IP
Addresses

Telephony
Environment
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6. To define IP Addresses for VoIP Mapping devices, scroll down to the IP Address for 
Devices section and do the following.

a. Click Add . An entry field appears.

b. Enter a single IP address. Example: 123.123.123.123

-or-

Enter a range of IP addresses. Example: 123.123.123.*

c. Click Add. The IP addresses are added to the list.

7. Repeat Step 6 until all IP addresses are added.

8. You are now ready to map devices to channels in one of the following ways:

• To automatically map devices to channels, continue with Step 9.

TIP: If you want a specific device mapped to a specific channel, map it manually before 
implementing Automatic Channel Mapping.

-or-

• To manually map devices to channels, continue with Step 10.

9. To automatically map devices to channels:

a. Scroll down and click Automatic Channel Mapping .

All Extension devices are automatically mapped to channels. Scroll down to the 
Channel Mapping section to view the results.

WARNING
Any changes made to this sections will restart your system when you click Apply.
Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.
In a Mixed Environment, if you make changes that temporarily stop recording, recording will be 
stopped in both environments.

1. Click Add

2. Click
Add
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If there are more devices than channels, only the first devices will be mapped. 

b. (optional) In the Channel Name field, edit the default name given to the channel. The 
Channel Name appears in Channel Monitor. Use a logical name.

c. Continue with Step 13.

10. Scroll down to the Channel Mapping section.

Each row represents a channel installed in your NICE Perform eXpress system. If you do not 
see the expected amount of channels, return to Procedure 2: Defining CTI and Recording 
on page 75 and increase the amount of Configured Channels. You may need to increase the 
number of channels in your license. Note that in a mixed environment, the total amount of 
channels in your license is shared between both telephony environments.

11. To map a device to a channel, do the following:

a. In the Device Name field, select the device name of an extension.

b. (optional) In the Channel Name field, edit the default name given to the channel. The 
Channel Name is displayed in Channel Monitor. Use a logical name.

12. Repeat Step 11 for each device.

13. Scroll down and click one of the following:

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Next Same as Save. 

After clicking Next, the Storage and Rules tab appears.
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In a Mixed Environment, if this is the second environment, Storage and Rules will have 
already been defined. NICE Perform eXpress configuration is complete.

14. Continue with Procedure 4: Configuring Storage on page 91.

Importing Channel Mapping 

Channel Mapping parameters can be imported from an external Excel file (Import file). To prepare 
an Import file suitable for Channel Mapping, see Creating Import Files for Channel Mapping 
on page 180. 

If Channel Mapping information was defined prior to importing a file, the following occurs:

• If a match is found, according to the Device Name, between the new import file and existing 
Channel Mapping definitions, then the entire new record overwrites the old one.

• If no match is found, the new record is added.

• Existing records are not deleted.

To import the file into NICE Perform eXpress, use the following procedure.

To import Channel Mapping parameters:

1. Click the Channel Mapping tab.

In a mixed environment, your Telephony Environment might be defined as the second 
Telephony Environment. If it does not appear at the top, scroll down to the correct 
environment or collapse the top section to view the correct Telephony Environment.

2. Click Import File .

• Apply Saves and activates changes in the system. 

If changes are made only to the Monitored Devices and Channel Mapping 
sections, recording is not interrupted. 

Note that when you click Apply, all changes from all tabs are applied. If 
changes were made on a different tab that interrupt recording, then recording 
will be interrupted now.

In a Mixed Environment, when recording is interrupted, it is interrupted for 
both environments.

Import
File

Telephony
Environment
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The Import Channel Mapping window appears.

3. Click Select to browse to, and select the Excel file with the Channel Mapping definitions. 

4. Click Import.

The Import Channel Mapping window displays the Summary area with summary 
information. If errors occur, the errors appear under the summary information.

5. Click Close.

The Channel Mapping tab is filled with the data from the Import file. You can edit this data if 
necessary. However, changes might not be saved if Import is repeated (either with the same, or 
a different file).

6. Scroll down and click one of the following:

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Next Same as Save. 

After clicking Next, the Storage and Rules tab appears.

Import Summary 
Information appears 
here
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7. Continue with Procedure 4: Configuring Storage on page 91.

• Apply Saves and activates changes in the system. 

If changes are made only to the Monitored Devices and Channel Mapping 
sections, recording is not interrupted. 

Note that when you click Apply, all changes from all tabs are applied. If 
changes were made on a different tab that interrupt recording, then recording 
will be interrupted now.

In a Mixed Environment, when recording is interrupted, it is interrupted for 
both environments.
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Procedure 4: Configuring Storage
In a Mixed Environment, the Storage and Rules configuration is shared by both Telephony 
Environments. Define Storage and Rules when you define the first Telephony Environment. 
Ensure that adequate space is provided for both environments. Then, when defining the second 
Telephony Environment, skip this procedure. 

The following Remote Storages are supported:

• Network Attached Storage (NAS)

• Storage Area Network (SAN)

• Local and shared network paths

The following ESMs are supported:

• EMC Centera

• Tivoli Storage Manager (TSM)

To configure an ESM, see Configuring ESM Storage on page 223.

Data Retention and Automatic Deletion for ESMs and Remote Storage

You can attach more than one NICE Perform eXpress system to the same partition. Depending on 
whether you are using an ESM or Remote Storage, NICE Perform eXpress responds differently 
when the partition reaches its full capacity. Response is as follows:

• ESM: When the partition reaches its full capacity, the oldest interactions are automatically 
deleted.

• Remote Storage: When the partition reaches its full capacity, one of the following occurs:

• Oldest interactions are automatically deleted.

-or-

• When retention is enabled, and the retention period is still in effect, new interactions are 
not stored. See Enabling Retention below.

To determine how much storage is left at the configured storage path for all systems combined, see 
the System Management application, System Status tab, and check the Storage area. 

IMPORTANT
Both ESMs and Remote Storage require a Remote Storage Path.
For the Remote Storage Path, verify the following:

• The Remote Storage Path must be defined on a dedicated partition or on a network path.

• The Remote Storage Path must be shared.

• The permissions for the Remote Storage Path folder must be for the same user account 
used for the NICE Perform eXpress installation.
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Enabling Retention

NICE Perform eXpress can be configured with or without data retention. Enabling retention 
applies the following changes to storage retention:

• The default number of days to store an interaction goes into effect.

• The default number of days to extend retention is set.

• You can create Retention Rules to change the retention for specific groups and calls.

When retention is not enabled, interactions are stored on the Remote Storage Path until no space is 
available. At this point, the oldest interactions are deleted first. Extended Retention is not available 
in the Interactions application.

How to Proceed 

1. Complete one of the following:

• Configuring Remote Storage on page 92

• Configuring Backup without Storage on page 103

2. If required, continue with Quality Management: Defining Screen Recording QM Rules 
on page 106

Configuring Remote Storage

Remote storage options supported by NICE Perform eXpress include NAS, SAN, as well as local 
and shared network paths. 

Understanding Retention Rules

Retention Rules filter interactions according to specified criteria, such as selected groups or phone 
numbers, and apply a Retention Period to these interactions. The order in which the rules are 
created impacts the retention of the interaction. The first rule in the list applies to all the 
interactions. The second rule applies to the interactions that remain, and so on. Make sure that you 
plan all Retention Rules before proceeding.

For a list of all Retention Rule options, see the table in Step 14 on page 96.

To configure remote storage:

1. Click the Storage and Rules tab.



93 Chapter 5: Configuring

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Procedure 4: Configuring Storage

Note: The Storage and Rules tab shown below is with Remote Storage options selected. Your 
initial view might vary.

2. If you do not have a QM license, or if you are not recording screens, continue with Step 4.

3. To record screens (a QM license is required), define a directory for storing screen recordings 
as follows:

a. In the Screen Recording Settings section, select Screen Recording Enabled. 

The Screen Recording Path and Allocated Space parameters appear.

b. In the Screen Recording Path enter the path of a valid local partition for screen storage. 

IMPORTANT: The path must be a local partition; not a shared partition or a network drive. 
Do not use partition C or E. Partitions D or F may be used.

Example: F:\Screens

c. In the Allocated Space enter the size allocated for screen storage.

Appears
only with a
QM license

Appears
only with a
QM license
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IMPORTANT: The storage path and space that you define cannot be changed!

Screen recording takes place only according to Quality Management rules. They will be 
defined at the end of this procedure.

4. If you do not have a predefined Central Administration configuration, continue with Step 6.

5. To use a predefined Central Administration configuration, do the following:

a. In the Select Storage Configuration list select the name of the TSM storage definition. 
The Storage Configuration fields will be automatically filled. They are read-only and 
cannot be modified.

b. Complete the remaining Storage Settings section as follows:

c. Continue with Step 9.

6. For Storage Type, select Remote Storage.

7. In the Storage Name field, enter a name for the storage configuration. 

Storage Setting Description Notes

Remote Storage 
Path

Enter the storage path, and click .

Defines the path where the data is 
saved before it is moved to the 
Centera server.

IMPORTANT: Do not use the C, D, 
or E partitions on the NICE Perform 
eXpress machine. It is recommended 
to use a network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports 
it, you can add more than one 
remote storage path.

• You cannot add the same path 
twice.

This path must be defined on a 
dedicated partition.

The permissions for the 
Remote Storage Path folder 
must be for the same user 
account that was used for the 
NICE Perform eXpress 
installation.

The oldest data saved at the 
Remote Storage Path 
location is automatically 
deleted as soon as no storage 
space is detected.

Before defining the Remote 
Storage Path, verify that 
there is enough free space at 
the Remote Storage Path 
location.

Archive Screen
Appears only in a QM 
environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the 
screen retention, screens will 
be deleted when their voice 
interaction is deleted.
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Example: NAS_NPeXpress. 

8. Complete the Storage Settings section as follows:

9. If you are not enabling data retention, clear the Retention Settings Enabled checkbox, and 
continue to Step 7.

Storage Setting Description Notes

Archiving 
Timeframe

Select Continuous to archive at all 
times, or select a timeframe for 
archiving to take place at the 
specified time every day.

Remote Storage 
Path

Enter the storage path, and click .

Defines the path where the data is 
saved before it is moved to the 
Centera server.

IMPORTANT: Do not use the C, D, 
or E partitions on the NICE Perform 
eXpress machine. It is recommended 
to use a network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports it, 
you can add more than one 
remote storage path.

• You cannot add the same path 
twice.

This path must be defined on a 
dedicated partition.

The permissions for the Remote 
Storage Path folder must be for 
the same user account that was 
used for the NICE Perform 
eXpress installation.

The oldest data saved at the 
Remote Storage Path location 
is automatically deleted as soon 
as no storage space is detected.

Before defining the Remote 
Storage Path, verify that there 
is enough free space at the 
Remote Storage Path location.

Archive Screen
Appears only in a QM 
environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the screen 
retention, screens will be deleted 
when their voice interaction is 
deleted.

Retention Period 
Days

Select the number of days to save the 
data on the remote storage. When the 
defined retention period is over, 
NICE Perform eXpress automatically 
deletes the data.

If the Retention Period Days 
value is 0, then there is no 
retention. Data is stored as long 
as space is available. When no 
space is available, the oldest data 
is deleted.



96 Chapter 5: Configuring

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Procedure 4: Configuring Storage

IMPORTANT: When retention is not enabled, interactions are stored on the Remote Storage 
Path until no space is available. At this point, oldest interactions are deleted first. Also, 
extended retention is not available in the Interactions application.

10. In the Default Retention Period (Days) field, enter the retention period that will apply to 
interactions not affected by Retention Rules. (See Understanding Retention Rules 
on page 92.) The maximum value is 10 years. (3,650 days). 

11. In the Default Time Period to Extend Retention field, enter the default Extend Retention 
period that appears in the Interactions application when extending the retention of an 
interaction. The Extend Retention Period can be longer than the Default Retention Period. 

Example: if the Default Retention Period is one year, and the Extend Retention Period is two 
years, the total retention for the interaction is three years. See the Administrator’s Guide for 
more information on Extend Retention. 

12. If there is no need to apply a different Retention Period to specific interactions, continue with 
Step 7 on page 104.

13. Plan all the Retention Rules for your site. The order in which you create the rules impacts the 
retention of the interaction. The first rule in the list applies to all the interactions. The second 
rule applies to the interactions that remain, and so on. See Understanding Retention Rules 
on page 92.

14. For each Retention Rule, do the following:

a. Click Add . The Add Rule window appears.
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b. Complete the Retention Rule definition as described below:

Rule Option Description How to...

Rule Name (Required field) Descriptive name of the 
rule. Example: 30 Day Retention - 
Internal.

Enter the name.

Retention 
Period

(Required field) Retention period in days 
to store the interaction that meets the 
criteria of the rule.

Enter the retention value.

Groups Filters according to the selected groups. Select a group. To select 
more than one group, press 
the Shift or Ctrl key while 
selecting.

Dialed 
Number

Filters the interactions by a specific 
incoming or outgoing number.

Enter the number.

Phone 
Number

Filters the interactions according to the 
phone number of the customer associated 
with the call. If the call is internal, the 
phone number is the destination of the 
call.

Enter the number.

Call 
Direction

Filters the interactions according to 
direction. Possible directions are:

• Incoming

• Outgoing

• Internal

Select a direction.

Advanced 
Deletion

Deletes the audio (and screen recordings) 
of the filtered interactions and their 
interaction details. No reference to these 
interactions are left in the system.

Warning: When the Advanced Deletion 
option is included in a Retention Rule, 
these interactions can never be played 
back again.

Select Permanently delete 
interactions and their 
audio.
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c. Click Save. The rule appears in the Retention Rules area.

d. Repeat Step 14 for each Retention Rule.

15. If a backup device is installed and configured, you can define backup in the Backup Settings 
section as follows: 

a. For Use Backup Device, select Yes. 

b. In the Retention Period (Days) field, enter the retention period to keep data on the 
backup media. The maximum value is 10 years. (3,650 days). When the retention period is 
in effect, you cannot overwrite the data on the backup media.

16. In a QM environment, complete Defining Screen Recording and Quality Management 
(QM). 

Quality Management rules do the following:

• Select interactions to be marked as QM

• Select interactions for screen recording (these interactions will also be marked as QM)

Use this procedure to define the criteria by which interactions will be marked for QM.

If you are recording screens, these rules will determine which screens are recorded.

You can define more than one rule, however an interaction needs only to meet the criteria of one 
rule, not all of them, to be marked for QM. The rules will be processed in the order in which they 
appear on the list.

Example: If an interaction meets the criteria of the first rule, it will be marked for QM and will not 
be matched against the remaining rules.
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To define Quality Management rules:

1. In the Storage and Rules tab, scroll down to the Quality Management Settings area.

2. Click Add .

The Add Rule window appears.

3. Complete the Quality Management Rule definition as follows:

Business Data appears
only if Business Data fields
were added

Screen Recording section
appears only if Screen 
Recording is Enabled

Table 5-1:  Quality Management Rule Definition

Section Description How to...

Rule Name (Required field) Descriptive name of the rule. 
Example: 30 day Screen Storage

Enter a name.
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Screen 
Recording

Appears only if Screen Recording is enabled.
Screens that are recorded are marked as QM.

To record screens that meet 
the criteria of this rule, select 
Enabled.
Screen Wrap-up Time is 
the amount of time, after the 
interaction ends, that screen 
recording continues.

Schedule How often and when are the amount of 
interactions specified in the Sampling section 
recorded.
EXAMPLE: You define Schedule as Daily from 
9:00 - 10:00, and Sampling as 10 interactions 
per agent. This means that every day between 
9:00 and 10:00, up to 10 interactions per agent 
will be recorded. If an agent has more than 10 
interactions, only the first 10 will be recorded. 

Select Schedule Type and 
then select the From/To time 
periods. Click the clock icon 
to the right of each field to 
select a time.

Sampling How many interactions will be selected for 
recording within each Schedule period.
Random - The defined number of interactions 
will be recorded per agent per Schedule 
period.
Percentage - A percentage of interactions will 
be recorded per Schedule period. 

Select Random or 
Percentage and then enter 
the number or percentage of 
interactions to record.

Table 5-1:  Quality Management Rule Definition (Continued)

Section Description How to...
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4. In the Add Rule window, click Save.

5. (Optional) Click Save to save the storage settings definition. The definition appears in the 
Select Storage Configuration drop-down list.

Filter Define a filter for determining which 
interactions will be marked for QM. An 
interaction must meet all the criteria in a rule in 
order to be marked for QM.
Groups - Only interactions from the selected 
groups can be marked for QM.
Dialed Number - Only interactions with this 
number can be marked for QM (incoming or 
outgoing is defined later in this area).
Phone Number - Only interactions with this 
phone number as the customer associated 
with the call can be marked for QM. If the call 
is internal, then Phone Number is the 
destination of the call.
Call Direction - Only interactions in this 
directions can be marked for QM:
Incoming
Outgoing
Internal
Duration greater than/Duration less than - 
The length of an interaction must be within this 
range in order to be marked for QM.
Business Data - If you have Business Data 
defined, you can define criteria according to 
Business Data values.
If a Business Data field is deleted, then any 
QM rule based on that field will automatically 
be deleted as well.

To select more than one 
group, press the Shift or Ctrl 
key while selecting.

Table 5-1:  Quality Management Rule Definition (Continued)

Section Description How to...

WARNING
Clicking Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.
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6. Scroll down and click one of the following:

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Apply Saves and activates changes in the system. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Screen Recordings Settings

• Backup Settings

In an active system, if changes were made in the following sections, recording 
will not be interrupted:

• Storage Settings (Storage services restart; recording is not 
interrupted)

• Quality Management Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.

• Done Appears only during first-time configuration. In a Mixed Environment, appears 
only when defining the first environment.

Saves data entered on this tab and applies all changes from all tabs in your 
system, enabling recording to begin.

After clicking Done, the User Administration opens so that you can begin 
adding Users to your system.
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Configuring Backup without Storage 
Some sites only play back recent calls and do not require the storage and archiving capabilities that 
NICE Perform eXpress offers. In order to run a NICE Perform eXpress system without storage and 
archiving, configure the Storage Configuration type to No Storage.

To configure backup without storage:

1. Click the Storage and Rules tab.

Note: The Storage and Rules tab shown below is with the No Storage options selected and a 
QM license. Your initial view might vary.

2. If you do not have a QM license continue with Step 4.

3. To record screens (a QM license is required), define a directory for storing screen recordings 
as follows:

a. In the Screen Recording Settings section, select Screen Recording Enabled. 

The Screen Recording Path and Allocated Space parameters appear.

b. In the Screen Recording Path enter the path of a valid local partition for screen storage. 

IMPORTANT: The path must be a local partition; not a shared partition or a network drive.

Example: F:\Screens

Appears
only with a
QM license

Appears
only with a
QM license
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c. In the Allocated Space enter the size allocated for screen storage.

IMPORTANT: The storage path and space that you define cannot be changed!

Screen recording takes place only according to Quality Management rules. They will be 
defined at the end of this procedure.

4. In the Select Storage Configuration drop-down list, select No Storage.

5. If a backup device is installed and configured, you can define backup in the Backup Settings 
section as follows: 

a. For Use Backup Device, select Yes. 

b. In the Retention Period (Days) field, enter the retention period to keep data on the 
backup media. The maximum value is 10 years. (3,650 days). When the retention period is 
in effect, you cannot overwrite the data on the backup media.

6. In a QM environment, complete Defining Screen Recording and Quality Management 
(QM). 

7. (Optional) Click Save to save the storage settings definition.

WARNING
Clicking Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.
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8. Scroll down and click one of the following:

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Apply Saves and activates changes in the system. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Screen Recordings Settings

• Backup Settings

In an active system, if changes were made in the following sections, recording 
will not be interrupted:

• Storage Settings (Storage services restart; recording is not 
interrupted)

• Quality Management Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.

• Done Appears only during first-time configuration. In a Mixed Environment, appears 
only when defining the first environment.

Saves data entered on this tab and applies all changes from all tabs in your 
system, enabling recording to begin.

After clicking Done, the User Administration opens so that you can begin 
adding Users to your system.
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Quality Management: Defining Screen Recording QM Rules
If your license includes Quality Management (QM), the Storage and Rules tab will contain 
sections for Screen Recording Settings and for Quality Management Settings.

If you have already defined screen recording while defining Storage or Backup, begin with 
Defining Quality Management (QM) Rules on page 107.

To initiate QM with screen recording, do the following:

1. Define a location on the NICE Perform eXpress machine for screen storage.

2. Define storage retention for archiving screens.

3. Define rules for marking interactions for QM.

Begin with Defining Screen Recording on page 106.

To initiate QM without screen recording, do the following:

• Define rules for marking interactions for QM

Begin with Defining Quality Management (QM) Rules on page 107.

Defining Screen Recording

Use this procedure to define the local directory and storage retention for screen recordings.

Screens will only be recorded according to Quality Management Rules. If you define Screen 
Recording but do not define QM rules, screens will not be recorded.

To define screen recording:

1. In the Storage and Rules tab, in the Screen Recording Settings section, select Screen 
Recording Enabled. 

The Screen Recording Path and Allocated Space parameters appear.

IMPORTANT 
In the following procedure you will be defining the storage path and size of the directory for 
screen recordings. Once defined, you cannot change the location or size of this directory.



107 Chapter 5: Configuring

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Quality Management: Defining Screen Recording QM Rules

2. In the Screen Recording Path enter the path of a valid local partition for screen storage. If 
the directory you define does not exist, it will be created now.

IMPORTANT: The path must be a local partition, not a shared partition or a network drive.

Example: F:\Screens

3. In the Allocated Space, enter the size allocated for screen storage. Be sure that enough free 
space is available in the defined path.

IMPORTANT: The storage path and space that you define cannot be changed!

Screen recording takes place only according to Quality Management rules. They will be 
defined at the end of this procedure.

4. Scroll down to the Storage Settings area and select Archive Screen.

The Screen Retention Period (Days) parameter appears.

5. In the Screen Retention Period (Days) field, enter the number of days that screens 
recordings should be saved.

NOTE: If an interaction is deleted due to a rule with Advanced Deletion, the screen 
recordings for the interaction will be deleted as well. 

6. You must define Quality Management Rules to record screens. Continue with Defining 
Quality Management (QM) Rules on page 107.

Defining Quality Management (QM) Rules

Quality Management rules do the following:

• Select interactions to be marked as QM

• Select interactions for screen recording (these interactions will also be marked as QM)

Use this procedure to define the criteria by which interactions will be marked for QM.

If you are recording screens, these rules will determine which screens are recorded.
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You can define more than one rule, however an interaction needs only to meet the criteria of one 
rule, not all of them, to be marked for QM. The rules will be processed in the order in which they 
appear on the list.

Example: If an interaction meets the criteria of the first rule, it will be marked for QM and will not 
be matched against the remaining rules.

To define Quality Management rules:

1. In the Storage and Rules tab, scroll down to the Quality Management Settings area.

2. Click Add .

The Add Rule window appears.

Business Data appears
only if Business Data fields
were added

Screen Recording section
appears only if Screen 
Recording is Enabled
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3. Complete the Quality Management Rule definition as follows:

Table 5-2:  Quality Management Rule Definition

Section Description How to...

Rule Name (Required field) Descriptive name of the rule. 
Example: 30 day Screen Storage

Enter a name.

Screen 
Recording

Appears only if Screen Recording is enabled.
Screens that are recorded are marked as QM.

To record screens that meet 
the criteria of this rule, select 
Enabled.
Screen Wrap-up Time is 
the amount of time, after the 
interaction ends, that screen 
recording continues.

Schedule How often and when are the amount of 
interactions specified in the Sampling section 
recorded.
EXAMPLE: You define Schedule as Daily from 
9:00 - 10:00, and Sampling as 10 interactions 
per agent. This means that every day between 
9:00 and 10:00, up to 10 interactions per agent 
will be recorded. If an agent has more than 10 
interactions, only the first 10 will be recorded. 

Select Schedule Type and 
then select the From/To time 
periods. Click the clock icon 
to the right of each field to 
select a time.

Sampling How many interactions will be selected for 
recording within each Schedule period.
Random - The defined number of interactions 
will be recorded per agent per Schedule 
period.
Percentage - A percentage of interactions will 
be recorded per Schedule period. 

Select Random or 
Percentage and then enter 
the number or percentage of 
interactions to record.
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4. In the Add Rule window, click Save.

Filter Define a filter for determining which 
interactions will be marked for QM. An 
interaction must meet all the criteria in a rule in 
order to be marked for QM.
Groups - Only interactions from the selected 
groups can be marked for QM.
Dialed Number - Only interactions with this 
number can be marked for QM (incoming or 
outgoing is defined later in this area).
Phone Number - Only interactions with this 
phone number as the customer associated 
with the call can be marked for QM. If the call 
is internal, then Phone Number is the 
destination of the call.
Call Direction - Only interactions in this 
directions can be marked for QM:
Incoming
Outgoing
Internal
Duration greater than/Duration less than - 
The length of an interaction must be within this 
range in order to be marked for QM.
Business Data - If you have Business Data 
defined, you can define criteria according to 
Business Data values.
If a Business Data field is deleted, then any 
QM rule based on that field will automatically 
be deleted as well.

To select more than one 
group, press the Shift or Ctrl 
key while selecting.

Table 5-2:  Quality Management Rule Definition (Continued)

Section Description How to...
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5. Scroll down and click one of the following:

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Apply Saves and activates changes in the system. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Screen Recordings Settings

• Backup Settings

In an active system, if changes were made in the following sections, recording 
will not be interrupted:

• Storage Settings (Storage services restart; recording is not 
interrupted)

• Quality Management Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.

• Done Appears only during first-time configuration. In a Mixed Environment, appears 
only when defining the first environment.

Saves data entered on this tab and applies all changes from all tabs in your 
system, enabling recording to begin.

After clicking Done, the User Administration opens so that you can begin 
adding Users to your system.
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Managing Users and Groups

The User Administration application enables managing users and groups, as well as defining 
global settings for the organization.
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Overview
Overview
The User Administration application enables managing users and groups, as well as defining 
global settings for the organization. 

Use the User Administration application to:

• View NICE Perform eXpress users in their respective groups. See Understanding Displayed 
User Information on page 116.

• Add new users by defining their login, permissions, passwords, and other settings. See 
Populating the System with Users on page 121.

• Delete a user from NICE Perform eXpress. See Deleting Users from the System 
on page 123.

• Add new groups to organize users. See Adding Groups of Defined Users on page 125.

• Delete a group. See Managing Groups on page 125 and Deleting Groups on page 126.

• Import an Excel file with pre-defined User and/or Group information. See Importing Users 
and Groups from an Excel File on page 127.

• Define password settings and login options for your organization. See Defining Organization 
Settings on page 128.

Impact of the Authentication Mode on User Administration

Depending on whether your site uses NICE Authentication or Windows Authentication, you 
configure different options in the User Administration application. A description of each 
authentication mode and its impact on the User Administration application is described below:

NICE Authentication Mode

Users are configured in the User Administration application, where they are assigned a login name 
and password. Users log in to NICE Perform eXpress by means of their login name and password.

Windows Authentication Mode

Active Directory users must have a valid user name and domain in order to be configured as NICE 
Perform eXpress users. In the User Administration application, Active Directory users are 
configured to be NICE Perform eXpress users. Once they are configured as NICE Perform 
eXpress users, they are automatically logged in to NICE Perform eXpress.

To change the authentication mode, see the Maintenance Guide.
114 Chapter 6: Managing Users and Groups

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)



Getting Started with the User Administration Application
Getting Started with the User Administration Application
This section describes how to start the User Administration application and explains the different 
areas and functionalities of the User Administration window. 

The User Administration application is started from the NICE Perform eXpress navigation bar.

To open the User Administration application:

1. Open NICE Perform eXpress.

2. On the navigation bar, click User Administration.

The User Administration application appears, displaying the User Management tab. 

The functionality of the User Administration application includes:

• User Management - Enables creating new users, editing existing ones, and deleting users 
who are no longer part of NICE Perform eXpress. See Understanding User Types and 
Privileges on page 117.

• Group Management - Enables creating, editing, and deleting groups. See Managing 
Groups on page 125.

• User/Group Import- Enables importing an Excel file with pre-defined user and/or group 
information. See Importing Users and Groups from an Excel File on page 127.

• Settings - Enables defining the organizational settings. These settings include the display of 
the user name, password policy, domain settings, and login options. See Defining 
Organization Settings on page 128.
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Understanding Displayed User Information
The User Administration application summarizes information regarding NICE Perform eXpress 
users:

Table 6-1:  User Administration Information

Name Description

(NICE Authentication only) 
User Name

Name of user (The name display is defined in the Settings tab. See 
Defining Organization Settings on page 128). 

User Type See Understanding User Types and Privileges on page 117.

Recorded
Displays the  icon if the user can be recorded. If the user cannot 
be recorded, no icon is displayed.
Note: The Recorded status reflects the user’s assigned role as it is 
defined in the Add or Edit window. 

Extension Displays the Extension/s or Station/s on which the user is being 
recorded. 

Agent ID Displays the Agent ID/s by which the user is identified. 

Defined as System User Displays whether or not the user is able to login to 
NICE Perform eXpress.

(NICE Authentication only) 
Login name

If defined as a user, the user login name is displayed.

OS Login Displays the MS Windows login name.

Email Displays the user’s email address.

Group Name Displays the group to which the user belongs.

User Status Displays the user status as one of the following:

• Active 

• Not Active 

• if user is not logged in for a certain period of time, according 
to the organization settings.

-or-

• if the user is defined as Not Active (when editing a user, 
see Understanding User Types and Privileges 
on page 117).

-or-

• if the user enters an invalid password several times, as 
defined in the Settings tab. (See Defining Organization 
Settings on page 128.)

• Deleted
Note: To view deleted users, in the User Management tab, 
select Show deleted users.
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Understanding User Types and Privileges
The User Administration application enables defining user types in the NICE Perform eXpress 
system. Each user type has specific privileges. The user types are:

• Agent

• Manager

• IT 

• QM - Only for sites with a Quality Management license. See the Quality Management Guide.

Agent

An agent is an employee who makes or answers telephone interactions. Each agent is assigned an 
extension number (in a fixed seating environment) or an agent ID (in a free seating environment). 
The extension number and the agent IDs are used by NICE Perform eXpress to correlate the 
recorded interactions to the relevant agent. 

Agents can have login rights to NICE Perform eXpress. In this case, agents can query and play 
back their own recordings. If the agent does not have access rights, the agent is defined in the 
system to ensure that recorded interactions are correctly correlated to this agent’s extension or ID.

Agent privileges are:

• View interactions in which the agent participated

• Query interactions in which the agent participated

• Play back interactions in which the agent participated

• Create/modify/delete private queries owned by the user

Manager

Managers are responsible for several agents. They can query and play back the interactions of their 
subordinates. If the manager is defined as a recorded manager, the interactions of this manager can 
also be queried and played back through the Interactions application. In this case, the manager 
needs to have an extension number or an agent ID.

Manager privileges are:

• View all interactions of the manager’s group

• Query all interactions of the manager’s group

• Create/modify/delete public queries owned by the user

• Play by any participant in the manager’s group

IT

The NICE Perform eXpress IT user has full access rights to the system and can also query and play 
back interactions of all the other users in the system. If the IT user is defined as recorded, the 
interactions of the IT user can be recorded. In this case, the IT user needs to have an extension 
number or an agent ID.
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IT privileges are:

• Access to all NICE Perform eXpress applications.

• View, query, and play back all user groups

• Query all interactions

• Create/modify/delete any public queries

• Access the User Administration application:

• Add/modify/delete user

• Add/modify/delete group

• Attach User Type (role)

• (NICE Authentication only) Edit organization password/security settings

• Modify/delete public queries owned by others

• Play by any participant

• Extend the retention of an interaction

• Find audio directly from the Logger
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Configuring User Privileges

Aside from the default user privileges assigned to each user type, you can add additional privileges 
to each user type. You configure these additional privileges from the Role Management tab.

Table 6-2:  Role Management - Additional Privileges by User Type

User Type Privilege Description

Agent Save interactions Enables saving interactions in ASF 
format in order to play them from 
other locations.

Manager Save interactions

Access the Evaluations 
application

Enables evaluating interactions 
according to a previously created 
form.

Access the Reporter 
application

Enables generating reports 
according to specific users and 
forms.

Access the Form Designer 
application

Enables creating forms according to 
the quality management needs of 
the organization.
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To add privileges to user types:

1. Click the Role Management tab. 

The Role Management tab appears.

2. Select the additional privileges to add to each user type. See Configuring User Privileges 
on page 119 for more information.

3. Click Save.

IT Access the Channel Monitor 
application

Enables playing back recordings of 
channel activity that were recorded 
from each channel, as well as 
monitoring the channel activity in 
real time.

Access the Interactions 
application

Enables playing back interactions.

Save interactions Enables saving interactions in ASF 
format in order to play them from 
other locations.

Access the Evaluations 
application

Enables evaluating interactions 
according to a previously created 
form.

Access the Reporter 
application

Enables generating reports 
according to specific users and 
forms.

Access the Form Designer 
application

Enables creating forms according to 
the quality management needs of 
the organization.

QM Access the Channel Monitor 
application

Enables playing back recordings of 
channel activity that were recorded 
from each channel, as well as 
monitoring the channel activity in 
real time.

Save interactions Enables saving interactions in ASF 
format in order to play them from 
other locations.

Table 6-2:  Role Management - Additional Privileges by User Type

User Type Privilege Description
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Populating the System with Users
NICE Authentication Only

When creating a user, you set their user type, permissions, login name, and password, as well as 
other settings.

Before You Begin

• When configuring managers and agents, you associate each user to a group. Verify that the 
necessary groups exist before you begin. 

• To record users, you also need the following information:

• Agent ID for each user with login permissions

• Extension associated with each Agent ID

• CTI type for each extension

• You can add additional privileges to each user type. To configure user privileges, see 
Configuring User Privileges on page 119.

To add a user to a group:

1. From the User Management tab, click Add . The Add User window appears.

NOTE: 
When there is more than one new user to add, you can create an Excel file based on the 
available template and import the Excel file rather than adding each new user 
separately. For details, see Importing Users and Groups from an Excel File 
on page 127.
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2. Enter the following information:

• First Name

• Last Name

3. In the User Type drop-down list, select a user type (role) to assign to the new user. The Add 
User window changes depending on the User Type. See Understanding User Types and 
Privileges on page 117 for a complete list of privileges. 

Available types are:

4. (NICE Authentication Only) In the User Settings area, complete the following:

• Login Name - Enter a NICE Perform eXpress login name for the new user.

• Password - Enter a NICE Perform eXpress password for the new user.

• Password Settings - Select the checkbox if you want the new user to change the 
password at next login. 

NOTE: The User Settings area does not appear if you selected Agents without login in 
Step 3.

Table 6-3:  Available User Types

User Type Query and Playback Access to additional applications

Agent without login No rights No access to NICE Perform eXpress and 
is only recorded.

Agent with login Can play back and query 
his/her own interactions 
only.

Has access to the Interactions application 
in NICE Perform eXpress.

Manager Can play back and query 
his/her subordinates’ 
interactions only.

Has access to his or her team member’s 
interactions and public queries.

Manager - Recorded Can play back and query 
his/her and his/her 
subordinates’ 
interactions.

Same as Manager, but his or her 
interactions are recorded as well.

IT Can play back and query 
all interactions.

Has access to NICE Perform eXpress 
applications as defined in the Role 
Management tab. See Configuring 
User Privileges on page 119.

IT - Recorded Can play back and query 
all interactions (including 
his/her own).

Same as IT, but his or her interactions are 
recorded as well.
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5. In the Recording Settings area, complete the following information:

• In the Extension drop-down field, select at least one extension. To remove an extension 
from the list, clear the checkbox. 

• In the Agent ID area:

• In the ID field, enter an Agent ID. Click Add .

• From the CTI drop-down list, select a CTI type. 

• To remove an Agent ID from the list, click Delete . 

NOTE: The Recording Settings area does not appear if you selected non-recorded entities, 
such as Manager or IT in Step 3.

6. In the Additional Settings area, from the Assign to Group field, select a group according to 
the user’s role as follows. 

• (Managers) Select the group which includes the manager’s team members.

• (Agents) Select the group that is associated with the agent’s manager.

NOTE: If the group you want does not exist, you can create a new group. See Adding Groups 
of Defined Users on page 125.

7. Enter the following additional information:

• OS Login Name - Operating System login name

• Domain (optional) - Select the name of the domain from the list.

• Email (optional)

8. Click Save.
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Deleting Users from the System

After deleting a user, you can still query for this user in the Interactions application. However, you 
cannot edit the user properties. To view deleted users, in the User Management tab, select Show 
deleted users. The User Status appears as Deleted.

To delete a user:

1. From the User Management tab, select a user.

2. Click Delete . 

3. The selected User Status changes to Deleted. 
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Managing Groups
Defining groups enables creating sets of users. For example, you can define a group for each 
manager, which would include all the manager’s subordinates. This section covers the following 
topics:

• Viewing Groups on page 125

• Adding Groups of Defined Users on page 125

• Deleting Groups on page 126

Before You Begin

You need to know the names of the groups and which users they include.

Viewing Groups

The Group Management window displays a list of groups and a description for each group (if 
added). 

The Group Management window is displayed below:

Adding Groups of Defined Users

For each manager, you add a group to include his or her team members. If you have more than one 
new group to add, you can create an Excel file based on the available template and import the 
Excel file rather than adding each new group separately. For details, see Importing Users and 
Groups from an Excel File on page 127.

To add a new group

1. From the Group Management tab, click Add . The Add New Group window appears.

2. In the Group Name field, enter a unique name for the group. 

3. In the Description field, enter a description for your new group.
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4. Click Insert.

Deleting Groups

You cannot delete a group with users associated to it - not even if a user in the group was deleted. 

You cannot delete the group All Users.

To delete a group:

1. From the Group Management tab, select a group.

2. Click Delete . The group is deleted from the list of groups.
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Importing Users and Groups from an Excel File
NICE Perform eXpress enables importing existing Excel files with pre-defined users and/or 
groups. Importing files eliminates the need to retype and define each entry, which saves time and 
increases accuracy. For more information about creating the Excel file, see Importing Users and 
Groups from an Import File on page 189.

To import an Excel file:

1. From the User Management tab, click Import File .

The Import window appears.

2. Click  to browse and select the Import file you want to import. 

3. Click .

The Import window now displays the Summary area with summary and error information.

4. Click Close.

The User and Group definitions are imported into the User Administration application.

Import 
Summary 
Information 
appears 
here

Error 
Messages 
appear here
127 Chapter 6: Managing Users and Groups

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)



Defining Organization Settings
Defining Organization Settings
You can define the following organization settings:

• Format of full name display (last and first)

• Domains of the users and the default domain

• Password policy (NICE Authentication Only)

• Login options (NICE Authentication Only)

Options change depending on whether your site uses NICE authentication or Windows 
authentication.

With Windows Authentication, the Settings window appears like this:

With NICE Authentication, the Settings window appears like this:
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To define organization settings:

1. Click the Settings tab. The Settings window appears.

2. In the User Display area, from the Formatted Name field, select the order in which you 
want the name to appear: Last, First or First, Last. 

3. (Optional) In the Domain Settings area, add a domain as follows:

a. Click .

b. In the Name field, enter the NetBIOS name of the domain.

c. To make the new domain the default domain, select Default Domain. 

d. Click Add to add the domain to the list.

4. (NICE Authentication only) In the Password Policy area, select the password policy you 
want to impose: 

Table 6-4:  Password Policy

Password Policy In this field, define:

Password Expiration Whether or not the password will expire, and if so after how 
many days.

Password Change Whether or not the user can change their password, and if so, 
when.

New User Password Whether the user should change their password at the first login.
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5. (NICE Authentication only) In the Login Options area, select Display login information, if 
you want the login information to appear each time the user logs in. The last login date and 
time is displayed as well as the number of failed login attempts. 

Below is an example of Login Information that appears when a user logs in if this option is 
selected:

6. (NICE Authentication only) Select when the Login ID should be deactivated: either according 
to the number of days it is inactive, or according to a number of failed attempts due to an 
invalid password.

7. Click Save .

Password History Whether past passwords should be saved, and if so, how many 
passwords should be saved.

Password Checking • Defines the minimum amount of characters. The minimum 
number of characters permitted is four. 

• Strict password checking enforces the following 
restrictions:

• Spaces cannot be the first or last character.

• Both numbers and letters must be used together.

• At least one character must be a capital letter.

• At least one character must be a special character such 
as $ or @.
Note: ~ is not identified as a special character. 

An example of such a password is: 1q2w3eG&.

Table 6-4:  Password Policy

Password Policy In this field, define:
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Initializing Backup

NICE Perform eXpress is set up to automatically run two types of Backup jobs:

Full Backup - Runs once a week, on Saturday

Differential Backup - Runs daily

If your NICE Perform eXpress system is installed before the first Full Backup is run, then the first 
time a Differential Backup is run, you will receive an error and backup will fail. To prevent this 
occurrence, you manually run a Full Backup as part of your system setup.

Contents

Why You Need to Run a Backup Before You Start ....................................................132

Running a First-Time Backup......................................................................................133
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Why You Need to Run a Backup Before You Start

Why You Need to Run a Backup Before You Start
NICE Perform eXpress automatically runs a full backup on all NICE databases every Saturday. On 
the other days of the week, it automatically runs a differential backup to back up the changes to the 
database since the full backup. 

When the NICE Perform eXpress system is installed on any day except Saturday, the automatic 
differential backup fails, since no full backup is available and the following message appears:

Cannot perform a differential backup for database "nice_express", because a current 
database backup does not exist.

As a preventive measure, you will now run a full backup job on your NICE Perform eXpress.
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Running a First-Time Backup
Full backups are run once a week, on Saturday. On all other days, NICE Perform eXpress runs a 
differential backup. Use the following procedure to initialize the backup process and make it ready 
for the first differential backup job.

To run an initial backup job:

1. From the Start menu, navigate to Programs > Microsoft SQL Server 2008 > SQL Server 
Management Studio.

The SQL Server Management Studio opens.

2. Expand SQL Server Agent > Jobs, and right-click Nice Full Backup.

3. Select Start Job at Step.

Select Start Job at Step
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Running a First-Time Backup

The Start Job window appears.

4. Click Start to back up all the databases in the NICE Perform eXpress system.

The Start Jobs progress window appears to display the status of each backup job as it 
progresses.

5. In the Status column, verify that the status of the backup jobs is Success, and click Close.

The NICE Perform eXpress databases are backed up.

Job status is success
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Testing your NICE Perform eXpress

NICE Perform eXpress is installed with a tool especially designed to test your complete 
installation. The eXpress Assistant tests your NICE Perform eXpress to ensure that the entire 
system is working.

The eXpress Assistant should be run after configuration is complete and users are defined.

Run the eXpress Assistant whenever a configuration change is made, such as adding or remapping 
channels to ensure that the entire system is working.

Contents
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eXpress Assistant Workflow
Below is a flowchart for the eXpress Assistant. For a detailed procedure, see Using the eXpress 
Assistant on page 137.
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Using the eXpress Assistant 
The following procedure describes how to use the eXpress Assistant. Each step is immediately 
followed with Possible Pitfalls for that step. For a graphic flow, see eXpress Assistant Workflow 
on page 136.

The eXpress Assistant should be run after configuration is complete and users are defined. If users 
are not defined, the eXpress Assistant can still test recording on a channel.

Step 1: Starting the eXpress Assistant

What is verified in this step: 

• If a Telephony Environment has been defined

• That the latest configuration changes have been applied

To start the eXpress Assistant:

1. On the NICE Perform eXpress server, select Start > Programs > NICE Perform eXpress > 
Tools > eXpress Assistant.

The eXpress Assistant Tool opens.

2. In the Welcome window, click Next.

In a Mixed Environment, the Choosing Environment window appears. Continue with 
Step 2: (Mixed Environments only) Choosing an Environment on page 139.

In a Single Environment, the Choosing Device window appears. Continue with 
Step 3: Verifying Connected Devices and Channels on page 140.
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Possible Pitfalls for Step 1

The following scenarios can occur as an outcome of Step 1.

• Telephony Environment not defined

An error message appears.

What to do:

a. Close the message box.

b. Close the eXpress Assistant.

c. Open NICE Perform eXpress and click the Configuration tab.

d. Define your system (Telephony Environment, channels, users, etc.).

e. Restart the eXpress Assistant.

• Changes were saved, but not Applied

Changes made in Configuration were saved, but not applied.

What to do:

a. Open NICE Perform eXpress and click the Configuration tab.

b. Click Apply.

c. In this window, click Next.

In a Mixed Environment, the Choosing Environment window appears. Continue with 
Step 2: (Mixed Environments only) Choosing an Environment on page 139.

In a Single Environment, the Choosing Device window appears. Continue with 
Step 3: Verifying Connected Devices and Channels on page 140.
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Step 2: (Mixed Environments only) Choosing an Environment

This step must be preceded by Step 1: Starting the eXpress Assistant on page 137.

There is no verification in this step; In a Mixed Environment, select the Telephony Environment 
being tested.

How to choose a Telephony Environment:

1. Select a Telephony Environment. 

2. Click Next.

The Choosing Device window appears.

3. Continue with Step 3: Verifying Connected Devices and Channels on page 140.
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Step 3: Verifying Connected Devices and Channels

This step must be preceded by one or both of the following:

Step 1: Starting the eXpress Assistant on page 137 

Step 2: (Mixed Environments only) Choosing an Environment on page 139

What is verified in this step: 

• That all devices are recognized for recording (visual verification by the tester)

• That the channel selected for this test is functioning properly

• It is possible to repeat this step as needed to test several channels

How to verify connected devices and channels:

1. Verify that all devices being recorded appear.

In Extension and VoIP environments, only devices mapped to channels appear in the eXpress 
Assistant. In trunk environments, devices do not have to be mapped; therefore all monitored 
devices appear.

2. Select a device to use for the rest of this test. 

3. Click Next.

The User Mapping window appears.

4. Continue with Step 4: Verifying User Mapping on page 142.
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Possible Pitfalls for Step 3

The following scenarios can occur as an outcome of Step 3.

• Not all devices appear in the list

Note that in Extension and VoIP environments, only devices mapped to channels appear in the 
eXpress Assistant. In trunk environments, devices do not have to be mapped; therefore all 
monitored devices appear.

What to do:

a. Open NICE Perform eXpress and click the Configuration tab.

b. In the Channel Mapping tab, add the devices to the list of Monitored Devices.

c. If necessary, map the devices to Channels.

• The selected device is mapped to a channel which is not functioning properly

The Channel Problem window appears.

Do one of the following:

• Correct the problem with the channel. Then click Repeat.

• Select a different device: Click Back.

• Troubleshoot: Click Troubleshooting . For a troubleshooting overview, see 
Navigating Troubleshooting Windows on page 146.

• Ignore the problem: Select Ignore this Problem. Then click Next. Continue with 
Step 4: Verifying User Mapping on page 142.
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Step 4: Verifying User Mapping

This step must be preceded by Step 3: Verifying Connected Devices and Channels on page 140.

What is verified in this step: 

• That the correct user is mapped to the selected device

How to verify user mapping:

1. The User Name and User ID of the User mapped to the selected device are displayed. Verify 
that the expected user appears. Use the following guidelines:

• Fixed seating indicates that each agent is directly associated with an extension, in a 
one-to-one relationship.

• Free seating indicates that seating is dynamic. The user in this window is the agent 
currently logged in to the extension.

• N/A indicates that no agent is currently connected to (fixed seating), or logged in to (free 
seating) the extension. You can still test the channel for recording.

2. Click Next.

The Call Recording window appears.

3. Continue with Step 5: Recording a Test Interaction on page 143

Possible Pitfalls for Step 4

The following scenario can occur as an outcome of Step 4.

• No User or the User is incorrect 

What to do:

a. Open NICE Perform eXpress and verify/correct one of the following:

• In the User Administration, correct the User definition.

• In the Configuration, change the extension mapped to the channel.

b. Troubleshoot: Click Troubleshooting . For a troubleshooting overview, see 
Navigating Troubleshooting Windows on page 146.
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Step 5: Recording a Test Interaction

This step must be preceded by Step 4: Verifying User Mapping on page 142.

What is verified in this step: 

• Incoming and outgoing interactions can be recorded on the selected device

 

How to record a test interaction:

1. To test incoming interactions: From a different phone, dial the indicated extension.

-or-

To test outgoing interactions: From the indicated extension, dial to a different phone.

The progress of the interaction is shown. 

2. Click Next.

The Searching Call window appears.

3. Continue with Step 6: Playing Back or Saving the Test Interaction on page 145

Possible Pitfalls for Step 5

The following scenario can occur as an outcome of Step 5.

• Progress does not advance

This indicates that the interaction was not automatically detected. You can search this or other 
devices for an interaction to test playback.

What to do:

a. Select Interaction was not detected. 

b. Click Next.
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The Searching Call window appear.

c. Define a search filter.

d. The default is to search only the selected device. To search all devices, mark Search all 
Devices.

e. Click Search .

A list of interactions appears.

f. Continue with Step 6: Playing Back or Saving the Test Interaction on page 145.
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Step 6: Playing Back or Saving the Test Interaction

This step must be preceded by Step 5: Recording a Test Interaction on page 143.

What is verified in this step: 

• Listen to the interaction from the previous step, or save it to another location. You need a 
sound card to hear the interaction 

How to play back or save an interaction:

1. To hear the interaction, select the interaction and click Play . A sound card must be installed 
on your machine. A playback window does not open.

2. To save the interaction, click Save .

3. To search for and play back or save other interactions, see Possible Pitfalls for Step 5 
on page 143.

4. Click Finish.

Your NICE Perform eXpress has tested successfully.
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Navigating Troubleshooting Windows
Troubleshooting is initiated from within the eXpress Assistant. There are two basic 
troubleshooting windows. The contents of each window is dynamic and changes according to the 
current state and the choices you make in the Troubleshooting process. A sample of each window 
is shown below.

The following options are available from all steps:

Restart Tool - return to the beginning of the eXpress Assistant.

Back to Tool - return to window from where you initiated troubleshooting.

Keyboard Shortcuts:

Backspace = Back to previous window

Enter = Next

Up arrow = Select the previous option

Down arrow = Select the next option

Parameters
from the 
eXpress Assistant
that are now 
being tested

Informative
message

Question or
Instructions

Possible
Answers
or 
Results
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Troubleshooting Workflow

The Troubleshooting window presents a question to help the eXpress Assistant pinpoint the 
problem. Select one of the possible answers. Then click Next to advance to the next window.

Troubleshooting Solutions

The Troubleshooting window presents a list of recommended actions to correct the problem 
determined by the Troubleshooting Workflow. Use this list as a guideline in resolving open issues.
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Preparing the CTI for NICE Perform 
eXpress

The CTI must be prepared for NICE Perform eXpress. The CTI is the responsibility of the 
Avaya Site Engineer. The following procedures are provided only as guidelines and 
recommendations.
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Verifying the Switch Configuration

In an environment using the AES Server, install the Avaya Application Enablement Services 
(AES) TSAPI Client on the NICE Perform eXpress.

After you prepare the Avaya AES Environment for the TSAPI Interface, you must:

• Define device groups, a list of monitored devices and a user.

• Then, you must associate the user with the device group.

These parameters are configured via the OAM.

Verifying the TSAPI License

Before configuring the Avaya TSAPI interface, verify the that Avaya TSAPI license is installed.

To verify the AES TSAPI Server license installation:

1. In Internet Explorer, enter the following URL: 

https://<IP address of the AES Server>/WebLM 

The Web License Manager window appears.
Figure A-1   Web License Manager Window

IMPORTANT
An Avaya System Administrator is responsible for all procedures in the Avaya environment.
All procedures in the Avaya environment are by recommendation only!
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2. In the sidebar, click Application_Enablement.

The Application Enablement window, Licensed Features list appears.
Figure A-2   Application Enablement Window - License Features List

3. In the Feature column, scroll down to VALUE_TSAPI_USERS.
Figure A-3   TSAPI License in Features List Window

• The Licensed column displays the amount of purchased licenses for the TSAPI 
monitored sessions.

• The Acquired column displays the TSAPI monitored sessions currently in use.

Verifying the TSAPI Service is Running

Before configuring the Avaya TSAPI interface, verify the that Avaya TSAPI Service is running, 
and that the license is valid.

To verify the TSAPI Service is running:

1. Log into the AES Server. In the left pain, click CTI OAM Home.

The CTI OAM Home page opens.

Acquired 
column

Licensed 
column
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2. For the TSAPI Service, verify the following:

• The Status column shows that the service is Running.

• The Licensed Purchased column shows Yes.
Figure A-4   AES Server - CTI OAM Home Page

Preparing the AES Environment

In an AES environment, the AES administrator must prepare the AES-CTI link connections. 
Below is a brief overview of the procedures that must be performed by the administrator.

Always check the Integration Description Document (IDD) regarding the latest versions.

Configure the Switch on AES

Below are general guidelines on how to configure the switch on the AES.

To configure the switch on the AES (general guidelines):

1. The administrator must define a switch via the OAM, and in the Communication Manager 
Avaya Site Administration.

IMPORTANT
An Avaya System Administrator is responsible for all procedures in the Avaya environment.
All procedures in the Avaya environment are by recommendation only!
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2. Log into OAM, and select Administration > Switch Connections.

The Switch Connections window appears.
Figure A-5   OAM: Switch Connections Window

3. In the field provided, enter the switch name. Then click Add Connection. 

The Set Password window appears.
Figure A-6   OAM: Set Password Window

4. In the Switch Password and Confirm Switch Password fields, enter the switch password 
using the following guidelines:

• Password must be between 12 - 16 alphanumeric characters.

• Password must be identical to the password assigned to the AES service in the 
Communication Manager.
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5. Click Apply.

The Switch Connections window reappears.
Figure A-7   OAM: Switch Connections Window

6. Click Edit CLAN IPs.

The Edit CLAN IPs window appears.
Figure A-8   OAM: Edit CLAN IPs Window



155 Appendix A: Preparing the CTI for NICE Perform eXpress

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Verifying the Switch Configuration

7. In the field provided, enter the IP address of the CLAN board. Then click Add Name or IP.

8. Repeat Step 7 for each CLAN board that is connected to the AES Server.

9. In the OAM sidebar, click Switch Connections to return to the Switch Connections window.
Figure A-9   OAM: Switch Connections Window

10. Click Edit H.323 Gatekeeper.

The Edit H.323 Gatekeeper window appears.
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Figure A-10   OAM: Edit H.323 Gatekeeper Window

11. In the field provided, enter the IP address of one of the CLAN boards. Then click 
Add Name or IP.

Configuring the AES on the Avaya Communication Manager

Configure IP services to activate the transport link between AE Services and ACM.

To configure IP services:

1. In the Avaya Site Administration, enter change ip-services.

The Communication Manager displays Page 1 of the IP SERVICES form.
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Figure A-11   Communication Manager - IP SERVICES Form - Page 1

2. Complete Page 1 of the IP SERVICES form, as follows:

a. In the Service Type field, enter AESVCS.

b. In the Local Node field, enter <nodename>. Where <nodename> is the name of the 
CLAN board.

c. In the Local Port field, leave the default 8765, unless you need to change it.

3. If you are adding more than one CLAN board for AE Services, repeat Step 2 for each CLAN 
board.

4. Go to Page 3 of the IP SERVICES form.
Figure A-12   Communication Manager - IP SERVICES Form - Page 3
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5. Complete Page 3 of the IP SERVICES form, as follows:

a. In the AE Services Server field, enter the <name> of the AES Server (this is the 
hostname of the AES Server). The field is case-sensitive. Example: AVAYA-AES

To obtain the name of the AES Server, at the command prompt, enter uname -n. 

b. In the Password field, enter the password defined in Step 4 of Configure the Switch on 
AES on page 152 (consisting of 12 to 16 alphanumeric characters).

c. Set the Enabled field to y.

6. After the switch is configured, the administrator must verify that the AES switch connection is 
active. To do this:

• In the OAM window, navigate to Status and Control > Switch Conn Summary, and 
verify that the Conn State of the switch is Talking.

Figure A-13   OAM: Switch Connections Summary

Define the CTI Link

A CTI link must be defined in the Communication Manager via the Avaya Site Administration. 

For TSAPI, the link type must be ADJ-TP.
Figure A-14   Communication Manager: Add CTI Link

Switch CTI

Switch CTI

Link Number

Link Type
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Configure the CTI Link Connection

The administrator must configure a CTI link via the AES OAM Admin. The Switch CTI Link 
Number must be the same link number defined in the Communication Manager. 

To configure the CTI link connection:

1. In AES OAM Admin, navigate to Administration > CTI Link Admin > TSAPI Links > Add 
Link. Then define the following:

• Link: Select a link number.

• Switch CTI Link Number: Select the same link that is defined in Communication 
Manager.

2. Click Apply Changes. 
Figure A-15   OAM: Add TSAPI CTI Link

Verify the CTI Link

After the CTI link is configured, the administrator should verify that the AES-CTI link connection 
is active and in a Talking state. 

To verify the CTI link:

1. From the AES OAM Administration, select Status and Control > Switch Conn Summary 
> Per Service Connections Details. 

Must match the link used in the 
Communication Manager
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Figure A-16   OAM: Verify Talking State 

2. Locate the Switch CTI Link # and verify that its Connection State is Talking.

Configuring the User and Monitored Devices Via the OAM

The user and monitored devices must be configured via the OAM. The steps below provide 
guidelines for the configuration - not detailed procedures.

To configure the user and monitored devices via the OAM:

1. Log in to OAM - User Management.

2. Define a user and password, as follows:

a. In the sidebar, select User Management > Add User.

Verify Talking state

IMPORTANT
This procedure must be performed together with an Avaya administrator.
The AES administrator must first prepare the AES-CTI link connection.
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Figure A-17   OAM: Add User 

b. Enter a User ID and User Password.

c. In the CT User field, select Yes.

d. Scroll to the end of the page and click Apply.

3. Log in as an administrator to CTI OAM Administrator.

4. Define the monitored devices one by one, as follows:

a. In the sidebar, select Administration > Security Database > Devices.
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Figure A-18   OAM: Devices

b. Enter a monitored device name and click Add Device. The Add/Edit Device window 
appears.
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Figure A-19   OAM: Add Device

c. Enter the Device ID and select the Device Type.

d. Leave the Tlink Group value as Any. 

e. Click Apply Changes. The device is added to the list of monitored devices.

f. Repeat these steps to define additional devices.

g. Scroll to the end of the page and click Apply.

5. In the sidebar, select Administration > Security Database > Device Group.

The Device Group window appears.

NOTE: You must now add ACD devices for monitoring agent activity and VDN 
information for call events information.
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Figure A-20   OAM: Device Group

• To create a new Device Group, proceed to Step 6.

• To add to an existing Device Group, proceed to Step 7.

6. To create a new Device Group, enter a device group name in the field provided, then click 
Add Device Group.

The Add / Edit Device Group window appears. Proceed to Step 8.

7. To add to an existing Device Group, select a device group from the list, then click 
Edit Device Group.

The Add / Edit Device Group window appears.
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Figure A-21   OAM: Add/Edit Device Group - Example

The Device Group name appears in the Device Group field.

8. In the Devices column, select the monitored devices to associate these devices with the group.

9. Scroll to the end of the page and click Apply Changes.

The Apply Changes to Device Group Properties window appears.
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Figure A-22   OAM: Apply Changes to Device Group Properties Window

10. Click Apply.

11. Link the new user with the device group, as follows:

a. In the sidebar, select Administration > Security Database > CTI Users > List All 
Users.

The CTI Users Page appears.

b. Select the appropriate username and click Edit. The Edit CTI User page appears.
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Figure A-23   OAM: Edit CTI User 

c. In the following fields, select the new device group (that you defined in Step 5 on 
page 163). 

• Call Origination and Termination

• Device/Device

• Call/Device

d. Select the checkbox Call / Call.

e. Scroll to the end of the page and click Apply Changes.

12. Do not close the OAM window. Continue with Verifying the Secure/Non-Secure Tlink 
on page 167.

Verifying the Secure/Non-Secure Tlink

When you configure the CTI Interface, enter the Tlink as the value of the Server Name parameter.

You will need the Tlink value when configuring NICE Perform eXpress.

To verify the Tlink:

1. In the OAM window, select Administration > Security Database > Tlinks.

The Tlinks window appears.
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Figure A-24   Tlinks Window

The list of Tlinks appear in the Tlink Name column.

In the above window, which serves as an example only, the Tlink consists of the following 
segments: 

• AVAYA - Vendor

• # - Separator

• AVAYA5 - Switch/Connection Name (as defined in Administration > Switch 
Connections)

NOTE: If your site uses more than one Tlink, make sure you choose the correct Tlink, 
according to the switch name.

Non-Secure Tlink:

Secure Tlink:

Vendor Switch 
Connection 
Name

Portal AES Server 
Name

Vendor Switch 
Connection 
Name

Secure 
Portal

AES Server 
Name
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• CSTA / CSTA-S - Secure / Non-Secure Portal

• AESMS1A - AES Server Name

2. Copy the correct Tlink name. 

You will need the Tlink value when configuring NICE Perform eXpress.

NOTE: If you run an Avaya Exerciser session to verify your configurations, the same 
TLink must appear in the SERVER NAME field of the Start Exerciser Session window:
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Adding Business Data (Additional CTI 
Fields)

If Business Data fields are available from the CTI, they can be added to your NICE Perform 
eXpress system according to the instructions provided.
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Business Data Guidelines

Business Data fields can be added according to the following guidelines:

• The Name field is case-sensitive! It must exactly match the CTI field name. Take care to 
enter it correctly!

• The number of fields of each type and size is as follows:

• If you are defining a Text field, then select a Text Field Size according to the following 
guidelines:

• 1 byte = 1 character

• You must select a size that is equal to or greater than the actual or maximum size of the 
CTI field.

• The amount of fields of each size is limited. Once you define the maximum amount of 
fields for a size, you will no longer be able to select that field size.

• If you select a size that is smaller than the CTI field, information will be truncated.

Examples: 

• You have 2 data fields that are 100 bytes each, select Text Field Type = 120 for each.

• You have 3 data fields that are 100 bytes each, select Text Field Type = 120 for 2 of the 
data fields. For the third data field, select Text Field Type = 80; the last 20 bytes of 
information will get truncated.

• IMPORTANT: In a Mixed Environment, only one set of Business Data fields is available. If 
you have two different CTIs, make sure to plan accordingly. Business Data fields used for one 
CTI will not be available for the other CTI. 

Example: If you define 2 text fields of size 30 for the first CTI, there will not be a text field of 
size 30 available for the second CTI.

• Once you define a field, you can edit only its Alias and Assign to Role values. You cannot edit 
its Name, Field Type, or Text Field Size.

Field Type Text Field Size Number of Available fields

Number n/a 6 

Text 20 6 

Text 30 2 

Text 40 8 

Text 80 8 

Text 120 2 
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• If you delete a Business Data definition, you can later add the same CTI field as a new 
Business Data field with different parameters. However, all information from the first 
definition will be lost.

Example: You define a Business Data field for ibirthday with alias Birthday and field Number. 
You then delete this field and redefine ibirthday with alias Birth and field Text 20. All data 
received from the ibirthday field while ibirthday was defined as Number will be lost.

Where will you see Business Data?

The next time a user, whose Role has access to a Business Data field logs in:

• There will be an additional column in the Interactions application labeled with the field’s Alias 
name.

• When defining a query, there will be an additional field for the Business Data, according to the 
Alias name.



174 Appendix B: Adding Business Data (Additional CTI Fields)

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Available Business Data Fields for Avaya TSAPI

Available Business Data Fields for Avaya TSAPI
The following Business Data field is available for Avaya TSAPI. For instructions on how to add it, 
see Defining Business Data on page 175.

Table B-1:  Additional Avaya TSAPI CTI Fields (Business Data) 

Name Description Avaya 
Reference

Field 
Type

Maximum 
Size Text Field Type

Distributing 
Device

Specifies the original 
distributing device of the 
call.

Distributing 
Device

Text 64 80

User 
Entered 
Code

Specifies the code/digits 
that may have been entered 
by the caller on a VDN.

User 
Entered 
Code

Text 25 30

User 
Entered 
Code collect 
VDN

Specifies the VDN that 
reports the User Entered 
Code.

collectVDN Text 64 80

User Info Contains information that 
another application has 
associated with the 
incoming call.

UUI Text 96 120

Queue ACD (Hunt) Text 50 80

HEXUCID Specifies Avaya UCID in 
hexadecimal format.

UCID Text 50 80
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Defining Business Data

Use the following procedure to define Business Data fields.

To define Business Data:

1. On the CTI and Recording tab, scroll down to the Business Data Settings section.

2. Click Add .

A new row appears.

3. In the Name field, enter the Name of the field exactly as it appears in the CTI. This field is 
case-sensitive!

4. In the Alias Name field, enter a user-friendly name. This is the name that will appear in 
queries and as a column heading in the Interactions window. The Alias Name can contain 
special characters and spaces.

5. To define a numeric field, select Number. The Text Field Size field becomes disabled. 
Continue with Step 6.

-or-

To define a text field, select Text. Then use these guidelines to select a Text Field Size.

• The amount of fields of each type and size is as follows:

• Select a Text Field Size that is equal to or greater than the size of the CTI field. If you 
select a size that is smaller than the CTI field, information will be truncated.

Type Size Available fields

Number n/a 6 

Text 20 6 

Text 30 2 

Text 40 8 

Text 80 8 

Text 120 2 

The Name field is case-sensitive!

1. Click Add to start a new row

2. Click Add after
completing the
information
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Example: The CTI field size is 30. You can select 40. Do not select 20; data will be 
truncated.

• Remember: The amount of fields of each size is limited. Once you define the maximum 
amount of fields for a size, you will no longer be able to select that size.

Example: Only two fields are available at size 120. Once you define two different fields as 
size 120, 120 will no longer appear in the drop-down list.

• In a Mixed Environment, only one set of Business Data fields is available. If you have 
two different CTIs, make sure to plan accordingly. Business Data fields used for one CTI 
will not be available for the other CTI.

6. In the Assign to Role field, select the Roles who will have access to this field.

7. In the new row, click Add.

8. Repeat this entire procedure for each Business Data field.

9. Click Save to save your changes.

10. Click Apply to active your changes in the system. Recording is not interrupted.
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Deleting Business Data 

If a Business Data field is deleted, then the following occurs:

• All filters in Quality Management rules based on the Business Data field are removed. The 
Quality Management rule that contained the Business Data field will remain.

• Data saved in the Business Data field will be lost. If the same field is later added again, the 
previous data will not be found.

To delete a Business Data field:

1. On the CTI and Recording tab, scroll down to the Business Data Settings section.

2. Select a row. Then click Delete .

A Confirmation message appears.

3. Click OK.

4. Click Save to save your changes.

5. Click Apply to active your changes in the system. Recording is not interrupted.

The Business Data field is deleted.
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C

Importing Channel Mapping and Users

Shared with:

All Installation guides (appendix)

Administrator’s Guide (chapter)

NICE Perform eXpress supports the use of Excel file templates for importing channel mapping 
and user definitions more quickly and efficiently.

Contents

Importing Channels from an Import File ....................................................................180

Importing Users and Groups from an Import File .....................................................189

IMPORTANT 
• To edit the Import file, Microsoft Excel must be installed on the NICE Perform eXpress 

machine.

• To view the Import file, Microsoft Excel or Excel Viewer needs to be installed on the NICE 
Perform eXpress machine. You can download the Excel Viewer from the Microsoft Web site 
at the following link: 
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1cd6acf9-ce06-
4e1c-8dcf-f33f669dbc3a
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Importing Channels from an Import File
NICE Perform eXpress supports importing channel mapping definitions using Excel files. This 
eliminates the need to add each monitored device and to map each channel separately on the 
Channel Mapping tab in the Configuration application. 

You can create new Import files or edit existing ones. When you import an existing file that has 
been edited, channel mapping definitions are updated by the Import file.

Important Guidelines

• In the Configuration application, the monitored devices definitions in the Import file are 
appended to the monitored devices currently listed in the Channel Mapping tab.

However, the channel mapping definitions in the Import file overwrite the channel mapping 
definitions currently displayed in the Channel Mapping tab.

To avoid overwriting existing channel mapping definitions, you must include the existing 
definitions in the Import file. 

• After importing the channel mapping definitions, always use the Import file to update these 
definitions. Any changes made directly in the user interface of the Channel Mapping tab will 
be overwritten the next time an Import file is imported.

• Each import file can have up to 200 channel mapping entries. If the import file contains more 
channels than allowed by your license, only the first channels will be imported. 

This section describes:

• Creating Import Files for Channel Mapping on page 180

• Updating Channel Mapping from Import Files on page 186

• Importing a Channel Mapping Import File on page 187

Creating Import Files for Channel Mapping

When importing channel mapping definitions, you define the channel mapping parameters in the 
NPX Channel Mapping Import Template V3.0.xls file. This Import file includes macros that 
customize the channel mapping parameters according to the telephony environment of your site.

Along with the procedure for creating an Import file to import channel mapping, this section also 
includes:

• Channel mapping parameters as they appear in the Import file: See Monitored Device and 
Channel Mapping Parameters on page 183.

• Background information regarding the Excel file template: See About the Channel Mapping 
Import Template on page 185.

To create files in Excel format for importing channel mapping: 

1. From the Channel Mapping tab in the Configuration application, note the existing channel 
mapping definitions. In Step 9 you will enter this information into the Import file.
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2. On the NICE Perform eXpress machine, from the Start menu, navigate to All Programs > 
NICE Perform eXpress > Import Templates.

3. Copy NPX Channel Mapping Import Template V3.0.xls to a location on your hard drive.

4. Open the template file. If prompted, Enable Macros.

The RecordingConfiguration tab appears.

5. From the File menu, select Save as and rename the file with a logical name (one containing 
the name of the telephony environment is recommended).

6. Open the new file you saved in the previous step and from the Select Telephony 
Environment drop-down list, select a Telephony Environment.

7. In the Number of Channels field, enter the number of channels to be mapped, including 
those that are already mapped in the Channel Mapping tab of NICE Perform eXpress.

Example: If 5 channels were previously mapped, and you are adding 15 more channels, enter 
the number 20.

8. Press the Tab key to select the cell with the GO! button. Then click GO! 

Important: If the cell with the GO! button is not selected, then the GO! button will not work.

The table fills up according to the selected telephony environment and number of channels.

9. Enter information according to the guidelines in Monitored Device and Channel Mapping 
Parameters on page 183.

Enter number of channels here
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10. In a Mixed Environment you will need two files, one for each environment. Repeat this 
procedure from Step 4 to create a second file.

11. Proceed to Importing a Channel Mapping Import File on page 187.

IMPORTANT 
You must include the channel mapping definitions that are already configured in the Channel 
Mapping tab of NICE Perform eXpress. These definitions will be overwritten when you import 
the Import file.
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Monitored Device and Channel Mapping Parameters

The RecordingConfiguration tab is used to define parameters that are for Channel Mapping in 
the Configuration. It has four possible sections; only those sections relevant to the selected 
environment appear. The following table describes all four sections and all possible parameters.
Table C-1:  Import File Channel Mapping Parameters

Section Instructions Parameter Description

Channel 
Mapping

A separate row is generated 
for each channel. Enter the 
details of the device 
mapped to each channel in 
the appropriate row. 
Each device entered in this 
section is automatically 
monitored and does not 
need to be entered in the 
Additional Monitored 
Devices section.

Special Considerations:

Trunks: Mapping is 
automatic. Define each 
device in the Additional 
Monitored Devices section.
Positions: Define the To 
Device from the Extension 
to Position Mapping section 
in this section.

Channel Index Internally generated value. Do 
not edit this column!

Channel Name Used for easy identification of 
each channel in the Channel 
Monitor. Default names are 
automatically generated. You 
can edit these names as 
needed.

Device Name The number or name of the 
device being recorded.
To use Positions, use this 
column as follows:

• To map Extensions to 
Positions, complete this 
field for all Positions.

• To map Positions to 
Extensions, complete this 
field for all Extensions.

• Use this value for the To 
Device field in the 
Extension to Position 
Mapping section.

Device Type The type of device being 
recorded. 
Example: Extension, Turret, 
Position, Station

• To map Extensions to 
Positions, complete this 
field for all Positions.

• To map Positions to 
Extensions, complete this 
field for all Extensions.

IP Address IP address of the telephone 
extension being recorded.
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Additional 
Monitored 
Devices

Define all devices that are 
monitored but not recorded.
All devices must be 
monitored to obtain relevant 
information, even if they are 
not recorded.

Special Considerations:

Trunk: Define all devices.
Positions: Define the From 
Device in this section.
Trunk with Positions: 
Define both the Extensions 
and the Positions.
BT Syntegra ITS Switch: 
This value must be 10 digits 
long. If necessary, use 
leading zeros.
To enter a range of values, 
type the first value and drag 
the column down.
Example:

Device Name The number or name of the 
device being monitored (not 
recorded).
For BT Syntegra ITS Switch, 
enter 10 digits.
Example: 0000000010

Device Type The type of device being 
monitored (not recorded). 
Example: IVR, ACD, VDN, 
Station

IP Addresses 
for Monitored 
Devices

IP Address IP address of the telephone 
extensions being monitored.
Enter a single IP address. 
Example: 123.123.123.123

-or-
Enter a range of IP addresses. 
Example: 123.123.123.*

Table C-1:  Import File Channel Mapping Parameters (Continued)

Section Instructions Parameter Description
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About the Channel Mapping Import Template

After installing NICE Perform eXpress, a shortcut to the template for importing channel mapping 
parameters is located in the Start menu at the following path: All Programs > NICE Perform 
eXpress > Import Templates.

The name of this template is: NPX Channel Mapping Import Template V3.0.xls

It is an Excel file that includes the channel mapping parameters according to the telephony 
environment of the site.

Extension to 
Position 
Mapping

Trunk: Define both the 
From Device and To 
Device in the Additional 
Monitored Devices section.
Extension and VoIP: 
Use the Device Number 
from the Channel Mapping 
section for the To Device.
Use the Device Number 
from the Additional 
Monitored Devices section 
for the From Device.

Direction Select Extension to Position or 
Position to Extension.

From Device Use this value in the Additional 
Monitored Devices section.

• To map Extension to 
Position, enter the device 
number/name of an 
Extension.

• To map Position to 
Extension, enter the 
device number/name of a 
Position.

To Device Use this value in the Channel 
Mapping section or in the 
Additional Monitored Devices 
section (for trunks).

• To map Extension to 
Position, enter the device 
number/name of a Position.

• To map Position to 
Extension, enter the 
device number/name of an 
Extension.

Table C-1:  Import File Channel Mapping Parameters (Continued)

Section Instructions Parameter Description
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The Excel file uses macros in order to display the necessary channel mapping parameters for the 
required telephony environment.

The template consists of two tabs: 

• RecordingConfiguration 

• Metadata - Do not change the information in this tab!

When creating a file for import, you enter information in the RecordingConfiguration tab. 

Updating Channel Mapping from Import Files

After creating a channel mapping import file, you can update the parameters in the file and then 
import the updated information into the Channel Mapping tab. When you import an updated file, 
only the parameters that have been changed are updated.

Example: Your original import file contains 10 channels. You purchase a new license with
20 channels (total of 30 channels). You can use the original import file. Just enter the new number.

To update channel mapping from an Import file: 

1. Open the Import file that includes the channel mapping parameters you want to change.

2. In the Number of Channels field, enter the additional number of channels to be mapped.

3. Press the Tab key, and then click the GO! button.

The additional channels are added to the file.

EXAMPLE:

In the example below, the telephony environment is Avaya TSAPI TDM Extension-Side, and 
the mappings for 10 channels are defined as follows:

IMPORTANT 
Make sure that the macros are enabled for use with the channel mapping import template.

TIP: If the GO! button is not active, make sure that the cursor is not inside a cell that 
already contains text.

Enter number of channels here
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4. Enter information according to the guidelines in Monitored Device and Channel Mapping 
Parameters on page 183. 

5. Save the file.

6. Proceed to Importing a Channel Mapping Import File on page 187.

Importing a Channel Mapping Import File

After creating or updating an Import file for importing channel mapping definitions, you import it 
from the Channel Mapping tab in the Configuration application. 

To import channel mapping:

1. In the Channel Mapping tab in the Configuration application, click Import File .

The Import Channel Mapping window appears.

2. Click  to browse and select the Import file for the current telephony environment. 

3. Click .

The Import Channel Mapping window now displays the Summary area with summary 
information. If errors occur, the errors appear under the summary information.

IMPORTANT
In sites with two telephony environments, verify that you are importing the channel mapping 
definitions for the correct environment. 

In this example, channel mapping
definitions are imported for 

TDM Extension-SideAvaya CDR
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4. Click Close.

The Channel Mapping tab is updated with the data from the Import file. 

TIP: To return to this or a previous tab, just click the tab.

After you click Next, the Storage and Archive tab becomes enabled.

• Save This will save your changes without applying them. You can continue to work 
on this page. Save does not make the settings active in your system. You will 
have to click Next to advance to the next tab.

• Apply This will apply the new setting to your system and make them active. Only 
Apply after you have completed all configuration definitions on all tabs and 
your system is not currently recording. Apply will interrupt recording.

WARNING
Apply interrupts recording, resulting in a loss of data! Only click Apply when 
you have determined that your system is not currently recording

• Next This will save your changes (the same as Save) and will advance to the next 
tab.

Import Summary 
Information 
appears here
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Importing Users and Groups from an Import File
NICE Perform eXpress supports importing an XLS file that defines users and groups in the User 
Administration application. Importing files, especially ones with many users or groups, can save 
you a great deal of time. Importing files avoids the need to retype and define each entry.

Important Guidelines

• Up to 200 users can be imported at a time. Each time you import the Import file, new users are 
added to the list of the current users.

• When users are already defined in the User Administration application, the Import file updates 
their information.

Creating Import Files for Importing Users and Groups

NICE Perform eXpress supports importing files in Excel (XLS) format. An Excel template is 
available that only requires filling in the mandatory fields. The template consists of three tabs: 

• Groups 

• Users

• Metadata

When creating a file for import, enter information in the Groups and Users tabs. 

Groups Tab

Assign groups according to Manager team members to allow the manager to run queries on team 
members interactions. 

Enter the following information in the Groups tab:

• Group Name

• Description

Users Tab

When creating a new user, set their user type, permissions, and other settings.

IMPORTANT
Do not change information in the Metadata tab!
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The table below lists the field name, description, and guidelines you must follow when filling 
information in the Users tab:
Table C-2:  Users Tab Description and Guidelines

Field Name Description Guideline

First Name First Name of user (The display is 
defined in the Settings tab.)

Mandatory

Last Name Last Name of user (The display is 
defined in the Settings tab.)

Mandatory

User Type The main user types (roles) are: 

• Agent 

• Manager

• IT

• QM
Each role has a predefined list of 
privileges.
For details, see User Type 
description in the Administrator’s 
Guide. 

Mandatory

Login Name If defined as a user, the user login 
name is displayed.

Password Login password If you do not enter a password, one 
of the following occurs, depending on 
whether the user is new or not:

• New user - the default password 
(nice1234) is used. At the first 
login, the user will be asked to 
change the password. 

• Existing user - the current 
password is retained and is not 
overwritten with the default 
password.

Group The group to which the user 
belongs.

If you defined a group in the Group 
tab, the group name will appear in a 
drop-down list in the User tab.
If you do not select a group in User 
tab, the new user will automatically 
belong to All Users.
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Extension The extension/s on which the 
user is being recorded.

You must enter an extension as it is 
defined in the Configuration 
application. 
For the BT Syntegra ITS Switch, 
this must be 12 digits long. If 
necessary, use leading zeros.
Example: 000000000010
Note - You can add an additional 
extension in the Extension # 2 field.

CTI for Extension CTI that is associated with the 
extension.

In sites with only one CTI, you do not 
have to enter a CTI. 
In sites with two CTIs, you must enter 
a CTI. 

Agent ID The Agent ID by which the user is 
identified.

CTI for Agent ID CTI that is associated with the 
Agent ID.

In sites with only one CTI, you do not 
have to enter a CTI. 
In sites with two CTIs, you must enter 
a CTI.

OS Login Name The Operating System login 
name.

Mandatory

Domain Name NetBIOS name of the domain

Email The user’s email address.

Extension # 2 The extension/s on which the 
user is being recorded.

You must enter an extension as it is 
defined in the Configuration 
application.
For the BT Syntegra ITS Switch, 
this must be 12 digits long. If 
necessary, use leading zeros.
Example: 000000000010

CTI for Extension #2 CTI that is associated with the 
second extension.

In sites with only one CTI, you do not 
have to enter a CTI. 
In sites with two CTIs, you must enter 
a CTI.

Agent ID #2 The second Agent ID by which 
the user is identified.

CTI for Agent ID # 2 CTI that is associated with the 
second Agent ID.

Table C-2:  Users Tab Description and Guidelines (Continued)

Field Name Description Guideline
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To create files in Excel format for importing users and groups: 

1. From the Start menu, navigate to All Programs > NICE Perform eXpress > Import 
Templates.

2. Copy NPX Users Import Template V3.0.xls to a location on your hard drive.

3. Double-click the template file to open it.

4. Enter information in the Groups and Users tabs according to the guidelines in Table C-2. Up 
to 200 users can be imported at a time.

5. Rename and save file.

Importing a Group and User Import File

You can create or edit users and/or groups via an Excel file, and then import it. To create an Excel 
file to import, see Creating Import Files for Importing Users and Groups on page 189.

To import groups and users:

1. From the User Management tab in the User Administration application, click Import File 

.

The Import window appears.

2. Click  to browse and select the Import file you want to import. 

3. Click .
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The Import window now displays the Summary area with summary and error information.

4. Click Close.

5. Click Save to save the updated definitions in the User Administration application.

6. Click Apply to apply the User Administration settings to NICE Perform eXpress.

Import 
Summary 
Information 
appears 
here

Error 
Messages 
appear here

WARNING
Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.
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Customizing NICE Perform eXpress

You can customize your NICE Perform eXpress with your company logo and/or customized text 
messages on the Welcome window.

Contents

Incorporating your Company Logo.............................................................................196

Adding Customized Text to the Welcome Window ...................................................197



196 Appendix D: Customizing NICE Perform eXpress

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Incorporating your Company Logo

Incorporating your Company Logo
You can customize your NICE Perform eXpress system to show your company’s logo on each 
NICE Perform eXpress screen. 

The file with your logo must meet the following requirements:

• File format - GIF

• Size - 58 x 22 pixels

To add a customized logo:

1. Confirm that the file with your logo is in GIF format and its size is 58 x 22 pixels.

2. On your NICE Perform eXpress machine, navigate to the following location:

...\Program Files\NICE Systems\NICE Perform eXpress\Applications\WebApplicatio
ns\CustomerSpecific\Images

3. Make a backup copy of logo.gif. You can keep it in the same folder. Example: NICE_logo.gif

4. Rename your logo file logo.gif and place it in the Images folder.

Refresh your NICE Perform eXpress application and your custom logo appears.

Your logo appears here
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Adding Customized Text to the Welcome Window
You can add two customized lines of text to the NICE Perform eXpress Welcome window. 

The two text lines can be of the following lengths:

• The Title line is limited to 50 characters.

• The Description line is limited to 70 characters.

To add customized text:

1. On your NICE Perform eXpress machine, navigate to the following location:

...\Program Files\NICE Systems\NICE Perform eXpress\Applications\WebApplicatio
ns\CustomerSpecific\Data

2. Make a backup copy of data.xml. You can keep it in the same folder. 
Example: NICE_data.xml

3. Open the data.xml file in an xml or text editor.

4. In the value field for loginTitle, enter a text string (maximum 50 characters) for the Title line.

Custom text
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5. In the value field for loginDescription, enter a text string (maximum 70 characters) for the 
Description line.

6. Save the data.xml file.

7. Reset the IIS service on the NICE Perform eXpress as follows: 

a. Open the Run window.

b. Enter iisreset.

c. Click OK.

Your custom text appears the next time you access NICE Perform eXpress.

Enter text here
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Localization - Language Support 

NICE Perform eXpress is supported in several languages. 

• To install NICE Perform eXpress, your machine must be set to English. 

• To configure and use NICE Perform eXpress, your machine must be set to your local 
language.

The sequence by which you change language settings and install NICE Perform eXpress is 
outlined in How to Install NICE Perform eXpress in Languages on page 200.

Contents

How to Install NICE Perform eXpress in Languages.................................................200

Setting the Regional Language...................................................................................201

Setting Language Preference......................................................................................202

First-Time Login and Licensing with Language Selection .......................................205
First-Time Login with NICE Authentication...............................................................205
First-Time Login with Windows Authentication (Active Directory) ............................207
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How to Install NICE Perform eXpress in Languages
Use the following workflow to install NICE Perform eXpress in languages other than English.

What to do... For instructions see...

1. Set the Regional Language to English Setting the Regional Language 
on page 201

2. Install NICE Perform eXpress Installing NICE Perform eXpress Software 
on page 34

-or-
Running a Silent Installation on page 44

3. Reset the Regional Language to the local 
language

Setting the Regional Language 
on page 201

4. Set Language Preference so that the local 
language has top priority

Setting Language Preference on page 202

5. Log into NICE Perform eXpress and do 
the following:
a. Select local language
b. Change password (NICE 

authentication only)
c. Activate license

First-Time Login and Licensing with 
Language Selection on page 205
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Setting the Regional Language
Before installing NICE Perform eXpress, the Regional Settings on the NICE Perform eXpress 
machine must be set to English. 

After the installation is complete, and before logging in to NICE Perform eXpress, reset Regional 
Settings to your local language.

To set Regional Language Settings:

1. From the Start menu, select Start > Settings > Control Panel > Regional and Language 
Options.

The Regional and Language Options window appears.

2. Select the Formats or Regional Options tab.

3. If you are about to install NICE Perform eXpress, 

a. Select English. Then click OK. 

b. Continue with one of the following:

• Installing NICE Perform eXpress Software on page 34 

• Running a Silent Installation on page 44

4. If you have completed the installation, then before you log in to NICE Perform eXpress, 

a. Select you local language. Then Click OK. 

b. Continue with Setting Language Preference on page 202.
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Setting Language Preference
Before beginning this procedure, confirm that the Regional Language on your machine is set to 
your local language. For instructions, see Setting the Regional Language on page 201.

To use NICE Perform eXpress in your local language, the language must have the highest priority 
in your Internet Options. Use the following procedure to select a language and set priority.

This procedure must be completed on the NICE Perform eXpress machine and on each 
workstation that accesses the NICE Perform eXpress.

The language that has priority determines the language and format of your calendar and how dates 
appear on your screen. If dates do not appear correctly, verify that the correct language has priority 
in the Language Preference window using the following procedure.

To set Language Preferences in Internet Explorer:

1. Open Internet Explorer and select Tools > Internet Options.

The Internet Options window appears.

Languages
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2. In the Appearance section, click Languages.

The Language Preference window appears.

3. If your local language does not appear in the list, do the following:

a. Click Add. 

The Add Language window appears.

b. Select a language. Then click OK.

If more than one dialect appears for your language, select any of them.

The language is added to the list in the Language Preferences window.

The first language
in the list has priority



204 Appendix E: Localization - Language Support

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Setting Language Preference

4. The Local language must be the first one in the list. To move a language to the top of the list, 
select the language. Then click Move Up.

5. Click OK to close the Language Preferences window.

6. Click OK to close the Internet Options window.

7. This procedure must be repeated on each workstation that accesses the NICE Perform 
eXpress.

8. Continue with First-Time Login and Licensing with Language Selection on page 205.
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First-Time Login and Licensing with Language Selection
In a NICE authentication environment, continue with First-Time Login with NICE 
Authentication on page 205.

-or-

In a Windows authentication (Active Directory) environment, continue with First-Time 
Login with Windows Authentication (Active Directory) on page 207.

First-Time Login with NICE Authentication

The first time you log in to NICE Perform eXpress you will use the default name, nice, and the 
default password, nice. You will then do the following:

• Change the default password. Have prepared a new password and record it in a safe place. 
Passwords are case-sensitive. Passwords are rated for their level of security.

• Activate your License key. 

To create a different user for login, see Managing Users and Groups on page 113.

If you experience any problems opening NICE Perform eXpress, see Configuring Internet 
Explorer for NICE Perform eXpress on page 212.

To log in to NICE Perform eXpress:

1. To open NICE Perform eXpress on the local machine, on the desktop, double-click the NICE 
Perform eXpress icon.

-or-

(from a remote server) Open an Internet Explorer window and enter the following URL: 
http://ServerName/npx 

Where ServerName is the name of the server where NICE Perform eXpress is installed. 
Example: NICE Perform eXpress is installed on a server named server1, the URL will be: 
http://server1/npx 

NOTE: You can change your NICE Perform eXpress system from NICE Authentication 
to Windows Authentication, or back again, after initial log in. In this case, the procedure 
varies slightly to accommodate existing users. See the Maintenance Guide for details.
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The NICE Perform eXpress Welcome window appears (in English).

2. Log in as follows:

a. In the Name field, enter nice.

b. In the Password field, enter nice.

c. Click Login.

The Change Password window appears.

3. Complete the Change Password window as follows:

a. In the Password field, enter nice.

b. In the New Password field, enter a new password. Passwords are case-sensitive. 

c. In the Confirm New Password field, re-enter exactly the same New Password.

d. Click Change Password.

The NICE Perform eXpress Welcome window reappears.
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4. Log in as follows:

a. In the Name field, enter nice.

b. In the Password field, enter your new password, defined in Step 3.

c. From the Select Language list, select the correct language.

d. Click Login.

NICE Perform eXpress opens in the correct language. 

NICE Perform eXpress is installed with a default (Provisional) license that is valid for a 
limited amount of time. The Licensing section displays the License Information and 
Expiration Date.

5. If you have direct internet access from the NICE Perform eXpress machine, continue with 
First-Time Licensing: Automatic Activation on page 60. 

-or-

If you do not have direct internet access from the NICE Perform eXpress machine, continue 
with Manually Activating or Updating a License on page 62.

First-Time Login with Windows Authentication (Active Directory) 

The default authentication mode for NICE Perform eXpress is NICE authentication. To log in to 
NICE Perform eXpress for the first time using Windows Authentication, use the Security 
Configuration Tool, as described below to switch authentication modes.

In the following procedure you do the following:

• Change from NICE authentication to Windows authentication. As part of this process 
you will define a Superuser with administrative privileges who you will use for first-time 
login.

• Activate your License key. 

If you experience any problems opening NICE Perform eXpress, see Configuring Internet 
Explorer for NICE Perform eXpress on page 212.

To switch to Windows authentication and log in:

1. On the NICE Perform eXpress machine, from the Start menu, select All Programs > NICE 
Perform eXpress > Tools > Security Configuration Tool.
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The Security Configuration Tool appears. 

2. For Authentication Mode, select Windows.

The Security Configuration Tool changes to reflect the required information.

3. In the Available Domains list, do the following:

a. Verify that all domains are listed. To add a domain, enter it’s name in an empty line. Only 
NetBIOS domain names are supported.

b. Optional. Select one domain as the Default domain. All users who are created without a 
domain will automatically be added to the default domain.
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4. In the User Settings area, do the following:

a. Enter the Windows user name for the Superuser Login. This must be a user with 
Administrative privileges. The Superuser will not appear in the NICE Perform eXpress 
User Administration or be seen by any other NICE Perform eXpress user.

b. Select a Superuser domain for the Superuser. To add a domain to this list, add it to the 
Available Domains list.

5. Optional. To automatically assign a domain to existing users who do not have a domain, select 
Apply Default Domain.

6. Click Apply to change the authentication mode.

7. Click Exit to exit the tool.

You NICE Perform eXpress is now in Windows Authentication mode. Continue this procedure 
for first-time login.

8. On the desktop, double-click the NICE Perform eXpress icon.

-or-

(from a remote server) Open an Internet Explorer window and enter the following URL: 
http://ServerName/npx 

Where ServerName is the name of the server where NICE Perform eXpress is installed. 
Example: NICE Perform eXpress is installed on a server named server1, the URL will be: 
http://server1/npx 
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NICE Perform eXpress opens in English.

9. From the Settings menu, select Language Selection.

The Language Selection window appears.

10. Select a language and click Close.

The NICE Perform eXpress window is refreshed in the correct language.

NICE Perform eXpress is installed with a default (Provisional) license that is valid for 
recording five channels for a three month period. The Licensing section displays the License 
Information and Expiration Date.

11. If you have direct internet access from the NICE Perform eXpress machine, continue with 
First-Time Licensing: Automatic Activation on page 60. 

-or-

If you do not have direct internet access from the NICE Perform eXpress machine, continue 
with Manually Activating or Updating a License on page 62.

Settings > Language Selection
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Preparing a Workstation for NICE Perform 
eXpress

There are three different workstation scenarios for NICE Perform eXpress users:

• A user (administrator) logs in to NICE Perform eXpress on the server where it is installed.

• A user (administrator) logs in to NICE Perform eXpress on a different machine connected to 
the NICE Perform eXpress server.

• An agent is recorded by NICE Perform eXpress and does not ever log in to NICE Perform 
eXpress.

To prepare a workstation proceed as follows:

1. In the first two scenarios above, the workstation must be prepared according to Configuring 
Internet Explorer for NICE Perform eXpress on page 212.

2. If you have a Quality Management (QM) license, the NICE Client installation must be run on 
all machines where agent screens will be recorded or played back. This includes all three of 
the above scenarios. See Quality Management: Client Installation for Screen Recording 
on page 216.

Contents

Configuring Internet Explorer for NICE Perform eXpress ........................................212

Quality Management: Client Installation for Screen Recording...............................216
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Configuring Internet Explorer for NICE Perform eXpress
The following procedure must be completed on any machine where a system user will log in to 
NICE Perform eXpress. This includes the NICE Perform eXpress machine if you will be logging 
in to NICE Perform eXpress from there.

Workstations where agent are recorded but do not log in to NICE Perform eXpress do not require 
this procedure.

In this procedure you will do the following:

1. Add about:blank as a Trusted Site. This is required to activate buttons that appear in NICE 
Perform eXpress message boxes. If the NICE Perform eXpress is installed on a Windows 2008 
server, this was done as part of the setup.

2. Add the server where NICE Perform eXpress is installed to the Local Intranet Sites. The 
server name added should be the host name or fully qualified domain name that will be used in 
the URL to log in to NICE Perform eXpress.

To configure Internet Explorer for your workstation:

1. In the Internet Explorer, go to Tools > Internet Options, and click the Security tab.

2. Select Trusted Sites.

3. Click Sites.
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The Trusted Sites window appears.

4. Clear the Require secure verification (https:) for all sites in this zone checkbox.

5. In the Add this Web site to the zone field, enter about:blank.

6. Click Add.

The about:blank site appears in the Web sites area.
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7. Click OK.

8. On the Security tab, select Local Intranet. 

9. Click Sites.

10. In some versions of Internet Explorer, the following window appears. Click Advanced.

The Local Intranet window appears.

Sites
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11. Clear the Require secure verification (https:) for all sites in this zone checkbox.

12. In the Add this Web site to the zone field, enter the URL of the NICE Perform eXpress 
server. Use the host name or fully qualified domain name that will be used in the URL to log in 
to NICE Perform eXpress.

Example: http://NPXserver or http://NPXserver.nice

13. Click Add.

The URL of the NICE Perform eXpress server appears in the Web sites area.

14. Click OK.

Clear
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Quality Management: Client Installation for Screen 
Recording

This section is applicable only with a Quality Management (QM) license, and only if screens are 
being recorded.

Prerequisites

• The site must have a push deployment tool to deliver the NICE Perform eXpress Client 
installation to each workstation.

• Administrative privileges are required for the NICE Perform eXpress Client installation.

• Write privileges are required to the ScreenAgent log folder for the ScreenAgent to save logs.

• .NET Framework 2.0.

Before You Begin:

• Verify the ScreenAgent machine hardware and software requirements. See NICE Perform 
eXpress Pre-Installation Guide.

General Information:

• The Client Installation is currently only for users in the QM environment.

• Run the Client Installation for users who need to record a screen, or for users who need to view 
a screen recording.

• The NICE Perform eXpress Client installation supports both interactive installation and silent 
installation (see relevant NICE Perform eXpress Installation Guide).

• Silent installation is recommended for deployment of large sites.

Client Installation Workflow

1. Download the Client installation files - see Accessing the Client Installation Files 
on page 217

2. Select one of the following installation methods:

• Running the Manual Installation on page 217

-or-

• Running the Silent Installation on page 220

IMPORTANT 
The Client Installation cannot be run on a NICE Perform eXpress server!
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Accessing the Client Installation Files

To run the Client installation, you must first download the files from the NICE Software 
Download Center to your computer.

To access the Client installation files:

1. From the NICE Software Download Center, copy and paste the Client Installation folder 
to a folder on your hard drive. Do not paste the folder onto your Desktop!

2. From its location on your local hard drive, navigate to the folder ...\NPXClientInstall.

The NPXClientInstall folder contains the following:

• NPXClientinstall.exe file.

• Silent Installation folder, which contains the following files:

• Params.config

• Readm.txt

Running the Manual Installation

The Manual installation method is used to install the Client installation manually, on each 
workstation.

To run the manual Client Installation:

1. From its location on your local hard drive, navigate to the folder ...\NPXClientInstall.

2. Double-click the NPXClientinstall.exe file.

After a few moments the NICE Perform eXpress Client Installation window appears, then the 
Welcome window appears. 

3. Click Next.
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The License Agreement window appears.

4. Select I accept the licensing terms and conditions, then click Next.

• If you are installing the Client Installation on a desktop (and not on a server), the 
following NICE Perform eXpress Server Location window appears.
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• If you are installing the Client Installation on a server, the following NICE Perform 
eXpress Server Location window appears.

5. In the Hostname / IP address field, enter the name of the NICE Perform eXpress server.

6. If you are installing the Client Installation on a desktop (and not on a server), click Next then 
continue with Step 9.

7. If you are installing the Client Installation on a server, in the Session connection mode 
area, select one of the following connection modes:

• Full Desktop sessions

-or-

• Published/Remote Apps sessions

8. Click Next.

9. The Installation Process window appears.
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The installation process takes a few minutes, then the Setup Wizard Completed window 
appears.

10. If the Setup wizard prompts you to restart you computer, you must select Yes, I want to 
restart my computer now.

11. Click Finish to complete the setup.

Running the Silent Installation

Use the Silent installation method to distribute the Client installation remotely, to many 
workstations.

To run the silent Client installation:

1. From its location on your local hard drive, navigate to the folder ...\NPXClientInstall\Silent 
Installation.

2. Using a text editor (such as Notepad), open the Params.config file.

3. Search for the string: NPX_SERVER_HOST.

4. In the value field, enter the Hostname or IP address of your NICE Perform eXpress server.

Enter the NICE 
Perform eXpress 
server Hostname 
or IP address
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5. For Citrix servers only, search for TERMINAL_SERVER_TYPE, and enter one of the 
following values to define a session connection mode:

• 0 - enter this for a Full Desktop session.

• 1 - enter this for a Published/Remote Apps session.

Note: 

• A Published/Remote Apps session: Citrix Server Published Applications and Microsoft 
RemoteApps enable a site administrator to publish a specific application to a group of 
users. In this environment, when a remote user connects to Published Applications or 
RemoteApps, a session is created and the published application runs inside the session.

• A Desktop session: A regular session where the user receives a session that contains his 
entire desktop.

Note: For Client Desktops, this value is not relevant.

6. Save the Params.config file, and verify that the latest file with your changes is in the same 
folder as the NPXClientinstall.exe file.

7. Double-click the NPXClientinstall.exe file.

8. Restart the computer.

Enter a value to 
define a session 
connection mode
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Configuring ESM Storage

NICE Perform eXpress supports the following ESMs:

• EMC Centera

• Tivoli Storage Manager (TSM)

Contents

Data Retention and Automatic Deletion for ESMs.....................................................224

EMC Centera Requirements ........................................................................................225

Configuring EMC Centera Storage..............................................................................227

Configuring Tivoli Storage Manager Storage.............................................................235

IMPORTANT
ESMs require a Remote Storage Path.
For the Remote Storage Path, verify the following:

• The Remote Storage Path must be defined on a dedicated partition or on a network path.

• The Remote Storage Path must be shared.

• The permissions for the Remote Storage Path folder must be for the same user account 
used for the NICE Perform eXpress installation.
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Data Retention and Automatic Deletion for ESMs 
You can attach more than one NICE Perform eXpress system to the same partition. When the 
partition reaches its full capacity, the oldest interactions are automatically deleted.

To determine how much storage is left at the configured storage path for all systems combined, see 
the System Management application, System Status tab, and check the Storage area. 

Enabling Retention

NICE Perform eXpress can be configured with or without data retention. Enabling retention 
applies the following changes to storage retention:

• The default number of days to store an interaction goes into effect.

• The default number of days to extend retention is set.

• You can create Retention Rules to change the retention for specific groups and calls.

When retention is not enabled, interactions are stored on the Remote Storage Path until no space is 
available. At this point, the oldest interactions are deleted first. Extended Retention is not available 
in the Interactions application.
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EMC Centera Requirements
This section provides general guidelines for creating a PEA file.

It is recommended that the EMC Centera administrator completes the following requirements to 
use NICE Perform eXpress with EMC Centera:

1. On the Centera server: 

• Create a user account for NICE Perform eXpress. 

• By means of Virtual Pools, define partitions for NICE Perform eXpress and map access 
permissions to these partitions. See What are Virtual Pools? on page 225.

2. Generate a PEA file for the NICE Perform eXpress account. See What is a PEA File? 
on page 226.

3. Put the PEA file on the NICE Perform eXpress machine.

4. On the NICE Perform eXpress machine, create a new environment variable named 
CENTERA_PEA_LOCATION. The value of the environment variable specifies the location 
of the PEA file. 

• Variable name: CENTERA_PEA_LOCATION 

• Variable value: <path of the PEA file> Example: C:\PEAFOLDER\MyPEA.pea

What are Virtual Pools?

Centera Star 3.0 and higher support Virtual Pools. The Virtual Pools feature adds data segregation 
capability to a Centera cluster. Clips from one application can be protected from being accessed by 
other applications using multiple pools. The administrator can determine the operations an 
application can perform on each pool. Replication and Restore can now also be performed on a 
subset of Clips by replicating only specific pools. Applications can query only the Clips within the 
pool(s) that it can access. Using Virtual Pools, administrators can set pool quotas and use quota 
alerts. In CentraStar 3.0, capacity reporting per pool represents the usage as seen by the customer, 
and it complements the existing raw cluster capacity reports.

TIP: 
• To create Environmental Variables in Windows 2003:

a. Right-click My Computer, and select Properties.
b. Select the Advanced tab, and click Environmental Variables.
c. In the Environmental Variables window, click New.

• To create Environment Variables in Windows 2008:

a. From the Control Panel, select User Accounts. The User Accounts window 
appears.

b. In the Tasks area, select Change my environment variables. The 
Environment Variables window appears.

c. Click New.



226 Appendix G: Configuring ESM Storage

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

EMC Centera Requirements

What is a PEA File?

Application authentication requires an application to provide credentials to the server before a 
connection can be established. The required credentials depend on the security protocol that is 
used. The credentials and specific server capabilities are bound on the server side using application 
profiles. The credential information will be stored on the client side, in a credential store. The Pool 
Access Information (PAI) module acts as a front end to this store, hiding the actual implementation 
from the application layer. 

The Centera Software Developers Kit (SDK) uses the PAI module to retrieve the necessary 
information for accessing a Centera cluster from the credential store. PAI modules are shared 
libraries/DLLs that allow you to provide your own PAI module implementation. The default PAI 
module is an EMC specific PAI module that uses an XML file to describe the pool access 
information. This file is called the Pool Entry Authorization (PEA) file.
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Configuring EMC Centera Storage
Using EMC Centera with NICE Perform eXpress requires completing the prerequisites described 
in EMC Centera Requirements on page 225. 

The following parameters are required before you can begin the storage configuration. If you are 
using a Central Administration definition, these parameters were already defined.

• At least one IP address to an access node on the primary Centera server

• (For Redundancy) At least one IP address to an access node on the secondary Centera server

Understanding Retention Rules

Retention Rules filter interactions according to specified criteria, such as selected groups or phone 
numbers, and apply a Retention Period to these interactions. The order in which the rules are 
created impacts the retention of the interaction. The first rule in the list applies to all the 
interactions. The second rule applies to the interactions that remain, and so on. Make sure that you 
plan all Retention Rules before proceeding.

For a list of all Retention Rule options, see the table in Step 15 on page 231.

As part of this procedure, if you have a Quality Management (QM) license, you can define Screen 
recording and Quality Management (QM) rules.

To configure EMC Centera storage:

1. Verify that the EMC Centera requirements are implemented as described in EMC Centera 
Requirements on page 225.

2. Click the Storage and Rules tab.
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Note: The Storage and Rules tab shown below is with EMC Centera options selected. Your 
initial view might vary.

3. If you do not have a QM license, or if you are not recording screens, continue with Step 5.

4. To record screens (a QM license is required), define a directory for storing screen recordings 
as follows:

a. In the Screen Recording Settings section, select Screen Recording Enabled. 

The Screen Recording Path and Allocated Space parameters appear.

b. In the Screen Recording Path enter the path of a valid local partition for screen storage. 

IMPORTANT: The path must be a local partition; not a shared partition or a network drive.

Appears
only with a
QM license

Appears
only with a
QM license
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Example: F:\Screens

c. In the Allocated Space enter the size allocated for screen storage.

IMPORTANT: The storage path and space that you define cannot be changed!

Screen recording takes place only according to Quality Management rules. They will be 
defined at the end of this procedure.

5. If you do not have a predefined Central Administration configuration, continue with Step 7.

6. To use a predefined Central Administration configuration, do the following:

a. In the Select Storage Configuration list select the name of the EMC Centera storage 
definition. The Storage Configuration fields will be automatically filled. They are 
read-only and cannot be modified.

b. Complete the remaining Storage Settings section as follows:

c. Continue with Step 10.

7. For Storage Type, select EMC Centera.

The storage configuration options change to those required for the EMC Centera ESM.

Storage Setting Description Note

Remote 
Storage Path

Enter the storage path, and click .

Defines the path where the data is saved 
before it is moved to the Centera server.

IMPORTANT: Do not use the C, D, or E 
partitions on the NICE Perform eXpress 
machine. It is recommended to use a 
network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports it, 
you can add more than one remote 
storage path.

• You cannot add the same path twice.

This path must be defined 
on a dedicated partition.

The permissions for the 
Remote Storage Path 
folder must be for the same 
user account that was used 
for the NICE Perform 
eXpress installation.

The oldest data saved at the 
Remote Storage Path 
location is automatically 
deleted as soon as no 
storage space is detected.

Before defining the Remote 
Storage Path, verify that 
there is enough free space at 
the Remote Storage Path 
location.

Archive Screen
Appears only in a 
QM environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the 
screen retention, screens 
will be deleted when their 
voice interaction is deleted.
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8. In the Storage Name field, enter a name for the storage configuration. 

Example: Centera_NPeXpress

9. Complete the Storage Settings section as follows:

Storage Setting Description Note

Primary IP Address Enter an IP address, and click .

Defines the access nodes on the primary 
Centera server.

Define at least one IP 
address. For internal 
redundancy within the 
server, you can define up to 
four IP addresses.

Secondary IP 
Address

Enter an IP address, and click .

Defines the access nodes on a secondary 
Centera server in case NICE Perform 
eXpress fails to connect to the primary 
Centera server.

For internal redundancy 
within the server, you can 
define up to four IP 
addresses.

Archiving 
Timeframe

Select Continuous to archive at all 
times, or define the timeframe during 
which archiving will take place daily.

Remote Storage 
Path

Enter the storage path, and click .

Defines the path where the data is saved 
before it is moved to the Centera server.

IMPORTANT: Do not use the C, D, or E 
partitions on the NICE Perform eXpress 
machine. It is recommended to use a 
network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports it, 
you can add more than one remote 
storage path.

• You cannot add the same path twice.

This path must be defined 
on a dedicated partition.

The permissions for the 
Remote Storage Path 
folder must be for the same 
user account that was used 
for the NICE Perform 
eXpress installation.

The oldest data saved at the 
Remote Storage Path 
location is automatically 
deleted as soon as no 
storage space is detected.

Before defining the Remote 
Storage Path, verify that 
there is enough free space at 
the Remote Storage Path 
location.

Archive Screen
Appears only in a QM 
environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the 
screen retention, screens 
will be deleted when their 
voice interaction is deleted.
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10. If you are not enabling data retention, then in the Retention Settings section, clear the 
Retention Settings Enabled checkbox and continue with Step 18.

IMPORTANT: When retention is not enabled, interactions are stored on the Remote Storage 
Path until no space is available. At this point, oldest interactions are deleted first and Extended 
Retention is not available in the Interactions application.

11. In the Default Retention Period (Days) field, enter the retention period that will apply to 
interactions not affected by Retention Rules. (See Understanding Retention Rules 
on page 227.) The maximum value is 10 years. (3,650 days). 

12. In the Default Time Period to Extend Retention field, enter the default Extend Retention 
period that appears in the Interactions application when extending the retention of an 
interaction. The Extend Retention Period can be longer than the Default Retention Period. For 
example, if the Default Retention Period is one year, and the Extend Retention Period is two 
years, the total retention for the interaction is two years. See the Administrator’s Guide for 
more information on Extend Retention. 

13. If there is no need to apply a different Retention Period to specific interactions, continue with 
Step 18 on page 233.

14. Plan all the Retention Rules for your site. The order in which you create the rules impacts the 
retention of the interaction. The first rule in the list applies to all the interactions. The second 
rule applies to the interactions that remain, and so on. See Understanding Retention Rules 
on page 227.

15. For each Retention Rule, do the following:

a. Click Add . The Add Rule window appears.



232 Appendix G: Configuring ESM Storage

NICE Perform eXpress Installation Guide Release 3.0: Avaya TSAPI Passive VoIP Dynamic IP (Rev. A1)

Configuring EMC Centera Storage

b. Complete the Retention Rule definition as follows:

c. Click Save. The rule appears in the Retention Rules area.

Rule Option Description How to...

Rule Name (Required field) Descriptive name of the 
rule. Example: 30 Day Retention - 
Internal.

Enter the name.

Retention 
Period

(Required field) Retention period in days 
to store the interaction that meets the 
criteria of the rule.

Enter the retention value.

Groups Applies rule to interactions with the 
selected groups.

Select one or more groups. 
Use the Shift and Ctrl keys 
to multi-select.

Dialed 
Number

Applies rule to interactions with a specific 
incoming or outgoing number.

Enter the number.

Phone 
Number

Applies rule according to the phone 
number of the customer associated with 
the interaction. If the interaction is 
internal, the phone number is the 
destination of the interaction.

Enter the number.

Call 
Direction

Applies rule according to direction. 
Possible directions are:

• Incoming

• Outgoing

• Internal

Select a direction.

Advanced 
Deletion

Deletes the audio (and screen recordings) 
of the selected interactions and their 
interaction details. No reference to these 
interactions are left in the system.

WARNING: When the Advanced 
Deletion option is included in a Retention 
Rule, these interactions can never be 
played back again.

Select Permanently delete 
interactions and their 
audio.
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d. Repeat Step 15 for each Retention Rule.

16. If a backup device is installed and configured, you can define backup in the Backup Settings 
section as follows: 

a. For Use Backup Device, select Yes. 

b. In the Retention Period (Days) field, enter the retention period to keep data on the 
backup media. The maximum value is 10 years. (3,650 days). When the retention period is 
in effect, you cannot overwrite the data on the backup media.

17. In a QM environment, proceed to Defining Screen Recording and Quality Management 
(QM). 

18. (Optional) Click Save to save the storage settings definition. The definition appears in the 
Select Storage Configuration drop-down list.

19. Do one of the following:

WARNING
Clicking Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Apply Saves and activates changes in the system. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Screen Recordings Settings

• Backup Settings

In an active system, if changes were made in the following sections, recording 
will not be interrupted:

• Storage Settings (Storage services restart; recording is not 
interrupted)

• Quality Management Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.
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• Done Appears only during first-time configuration. In a Mixed Environment, appears 
only when defining the first environment.

Saves data entered on this tab and applies all changes from all tabs in your 
system, enabling recording to begin.

After clicking Done, the User Administration opens so that you can begin 
adding Users to your system.
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Configuring Tivoli Storage Manager Storage

Use the following list to prepare for configuring Tivoli Storage Manager (TSM) storage.

• The TSM Administrator completes the following:

• On the TSM server, defines TSM file space by means of the TSM Server Administrator.

• On the NICE Perform eXpress machine, installs and configures the TSM client 
(version 5.5).

• The NICE Perform eXpress Installer verifies that the TSM Server and Client are properly 
functioning at the site.

• Specifically for TSM, have the following ready (If you are using a Central Administration 
definition, these parameters were already defined):

• Path to the directory of the TSM client installation

• Path to the TSM client user option file

• Path to the error log of the TSM client

• Path to the TSM client configuration file

• Administrator username for the TSM server

• Administrator password for the TSM server

• Username for the TSM client

• Password for the TSM client

Understanding Retention Rules

Retention Rules filter interactions according to specified criteria, such as selected groups or phone 
numbers, and apply a Retention Period to these interactions. The order in which the rules are 
created impacts the retention of the interaction. The first rule in the list applies to all the 
interactions. The second rule applies to the interactions that remain, and so on. Make sure that you 
plan all Retention Rules before proceeding.

For a list of all Retention Rule options, see the table in Step 15 on page 231.

To configure TSM:

1. Verify that the TSM Administrator did the following:

• On the TSM server, defined TSM file space by means of the TSM Server Administrator.

• On the NICE Perform eXpress machine, installed and configured the TSM client 
(version 5.5).

2. Verify that the TSM Server and Client are properly functioning at the site.

3. Click the Storage and Rules tab. 
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Note: The Storage and Rules tab shown is with TSM options selected. Initial view might vary.

4. If you do not have a QM license, or if you are not recording screens, continue with Step 6.

5. To record screens (a QM license is required), define a directory for storing screen recordings 
as follows:

a. In the Screen Recording Settings section, select Screen Recording Enabled. 

The Screen Recording Path and Allocated Space parameters appear.

b. In the Screen Recording Path enter the path of a valid local partition for screen storage. 

IMPORTANT: The path must be a local partition; not a shared partition or network drive.

Example: F:\Screens

Appears
only with a
QM license

Appears
only with a
QM license
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c. In the Allocated Space enter the size allocated for screen storage.

IMPORTANT: The storage path and space that you define cannot be changed!

Screen recording takes place only according to Quality Management rules. They will be 
defined at the end of this procedure.

6. If you do not have a predefined Central Administration configuration, continue with Step 6.

7. To use a predefined Central Administration configuration, do the following:

a. In the Select Storage Configuration list select the name of the TSM storage definition. 
The Storage Configuration fields will be automatically filled. They are read-only and 
cannot be modified.

b. Complete the remaining Storage Settings section as follows:

c. Continue with Step 11.

Storage Setting Description Notes

Remote Storage 
Path

Enter the storage path, and click .

Defines the path where the data is 
saved before it is moved to the 
Centera server.

IMPORTANT: Do not use the C, D, 
or E partitions on the NICE Perform 
eXpress machine. It is recommended 
to use a network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports 
it, you can add more than one 
remote storage path.

• You cannot add the same path 
twice.

This path must be defined on a 
dedicated partition.

The permissions for the 
Remote Storage Path folder 
must be for the same user 
account that was used for the 
NICE Perform eXpress 
installation.

The oldest data saved at the 
Remote Storage Path 
location is automatically 
deleted as soon as no storage 
space is detected.

Before defining the Remote 
Storage Path, verify that 
there is enough free space at 
the Remote Storage Path 
location.

Archive Screen
Appears only in a QM 
environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the 
screen retention, screens will 
be deleted when their voice 
interaction is deleted.
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8. For Storage Type, select TSM.

The storage configuration options change to those required for the TSM.

9. In the Storage Name field, enter a name for the storage configuration. 

Example: TSM_NPeXpress

10. Complete the Storage Settings section as follows:

NOTE: The TSM option appears only after installing the Tivoli client on the NICE 
Perform eXpress machine.

Storage Setting Description Notes

DSMI Dir Path Path to the directory of the TSM client 
installation.

DSMI Config Path Path to the TSM client user option file.

DSMI Log Path Path to the error log of the TSM client.

Configuration File 
Path

Path to the TSM client configuration 
file.

Administrator 
Username

Administrator login to the TSM server.

Administrator 
Password

Administrator password to the TSM 
server.

Client Node 
Username

Login to the TSM client.

Client Node 
Password

Password for the TSM client.

Archiving Timeframe Select Continuous to archive at all 
times, or select a timeframe for 
archiving to take place at the specified 
time every day.
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11. If you are not enabling data retention, then in the Retention Settings section, clear the 
Retention Settings Enabled checkbox, and continue to Step 18.

IMPORTANT: When retention is not enabled, interactions are stored on the Remote Storage 
Path until no space is available. At this point, oldest interactions are deleted and Extended 
Retention is not available in the Interactions application.

12. In the Default Retention Period (Days) field, enter the retention period that will apply to 
interactions not affected by Retention Rules. (See Understanding Retention Rules 
on page 235.) The maximum value is 10 years. (3,650 days). 

13. In the Default Time Period to Extend Retention field, enter the default Extend Retention 
period that appears in the Interactions application when extending the retention of an 
interaction. The Extend Retention Period can be longer than the Default Retention Period. For 
example, if the Default Retention Period is one year, and the Extend Retention Period is two 
years, the total retention for the interaction is two years. See the Administrator’s Guide for 
more information on Extend Retention. 

14. If there is no need to apply a different Retention Period to specific interactions, continue with 
Step 18 on page 233.

Remote Storage 
Path

Enter the storage path, and click .

Defines the path where the data is saved 
before it is moved to the Centera server.

IMPORTANT: Do not use the C, D, or E 
partitions on the NICE Perform eXpress 
machine. It is recommended to use a 
network path.

Examples: 

• \\npx\archive 

• \\1.1.1.1\archive

Notes: 

• If your storage policy supports it, 
you can add more than one remote 
storage path.

• You cannot add the same path 
twice.

This path must be defined 
on a dedicated partition.

The permissions for the 
Remote Storage Path 
folder must be for the same 
user account that was used 
for the NICE Perform 
eXpress installation.

The oldest data saved at the 
Remote Storage Path 
location is automatically 
deleted as soon as no 
storage space is detected.

Before defining the 
Remote Storage Path, 
verify that there is enough 
free space at the Remote 
Storage Path location.

Archive Screen
Appears only in a QM 
environment

To archive screen recordings, select 
Archive Screen. Then define the 
Screen Retention Period.

If the retention for voice 
recording is less than the 
screen retention, screens 
will be deleted when their 
voice interaction is deleted.

Storage Setting Description Notes
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15. Plan all the Retention Rules for your site. The order in which you create the rules impacts the 
retention of the interaction. The first rule in the list applies to all the interactions. The second 
rule applies to the interactions that remain, and so on. See Understanding Retention Rules 
on page 235.

16. For each Retention Rule, do the following:

a. Click Add . The Add Rule window appears.

b. Complete the Retention Rule definition as follows:

Rule Option Description How to...

Rule Name (Required field) Descriptive name of the 
rule. Example: 30 Day Retention - 
Internal.

Enter the name.

Retention 
Period

(Required field) Retention period in days 
to store the interaction that meets the 
criteria of the rule.

Enter the retention value.

Groups Filters according to the selected groups. Select a group. To select 
more than one group, press 
the Shift or Ctrl key while 
selecting.

Dialed 
Number

Filters the interactions by a specific 
incoming or outgoing number.

Enter the number.
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c. Click Save. The rule appears in the Retention Rules area.

d. Repeat Step 15 for each Retention Rule.

17. If a backup device is installed and configured, you can define backup in the Backup Settings 
section as follows: 

a. For Use Backup Device, select Yes. 

b. In the Retention Period (Days) field, enter the retention period to keep data on the 
backup media. The maximum value is 10 years. (3,650 days). When the retention period is 
in effect, you cannot overwrite the data on the backup media.

Phone 
Number

Filters the interactions according to the 
phone number of the customer associated 
with the call. If the call is internal, the 
phone number is the destination of the 
call.

Enter the number.

Call 
Direction

Filters the interactions according to 
direction. Possible directions are:

• Incoming

• Outgoing

• Internal

Select a direction.

Advanced 
Deletion

Deletes the audio (and screen recordings) 
of the filtered interactions and their 
interaction details. No reference to these 
interactions are left in the system.

Warning: When the Advanced Deletion 
option is included in a Retention Rule, 
these interactions can never be played 
back again.

Select Permanently delete 
interactions and their 
audio.

Rule Option Description How to...
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18. In a QM environment, proceed to Defining Screen Recording and Quality Management 
(QM). 

19. (Optional) Click Save to save the storage settings definition. The definition appears in the 
Select Storage Configuration drop-down list.

20. Do one of the following:

WARNING
Clicking Apply interrupts recording, resulting in a loss of data! Only click Apply when you have 
determined that your system is not currently recording.

• Save Saves data entered on this tab. Does not make it active in the system.

IMPORTANT! You must click Apply to activate changes in the system.

• Apply Saves and activates changes in the system. 

Interrupts recording in an active system if changes are made in any of the 
following sections: 

• Screen Recordings Settings

• Backup Settings

In an active system, if changes were made in the following sections, recording 
will not be interrupted:

• Storage Settings (Storage services restart; recording is not 
interrupted)

• Quality Management Settings

Note that when you click Apply, all changes from all tabs are applied. One of 
the sections can cause recording to be interrupted, even if the change is not on 
the current tab.

In a Mixed Environment, when recording is interrupted, it is interrupted on 
both environments.

• Done Appears only during first-time configuration. In a Mixed Environment, appears 
only when defining the first environment.

Saves data entered on this tab and applies all changes from all tabs in your 
system, enabling recording to begin.

After clicking Done, the User Administration opens so that you can begin 
adding Users to your system.
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